der sur disquette.

e ENTREE ET SORTIE DU MODE DE SAUVEGARDE

“STORE”

Pour entrer en mode de sauvegarde, appuyer sur la touche
STORE du panneau de commandes. A partir de ce mode, vous
allez pouvoir choisir la fonction de sauvegarde de multis [F2]

(“Multi”) ou de sauvegarde de sonorités [F3] (“Voice™), en

fonction du type de données qui doit étre sauvegardé. Pour
quitter le mode, appuyer une ou plusieurs fois sur EXIT ou
appuyer sur une touche de mode du panneau de commandes.

Le mode “Store” permet de sauvegarder des multis (avec ou sans données de séquences de
morceaux) dans une mémoire de multis de morceaux interne (01 a 16) et de sauvegarder des
sonorités pré-sélectionnées et originales dans la banque® de sonorités internes. Ce mode de
sauvegarde convient particuliérement pour organiser vos sonorités et multis avant de les sauvegar-

Le mode de sauvegarde de multis permet de sauvegarder un multi de la mémoire de morceaux
sélectionnée sous un emplacement de mémoire de morceaux différent (de 01 a 16). Les données de
multi pouvant étre sauvegardées sous un emplacement de mémoire de morceaux comprennent tous
les réglages de multis (c’est-a-dire, les réglages MIDI, de mélangeur et autres parametres pour les 16
pistes de sonorités instrumentales) et autres données de configuration.

Lors de la définition des parameétres dans un multi ainsi que lors de I'enregistrement ou I'édition

de séquences de morceaux dans la mémoire de multis de morceaux, tous les réglages sont “entrés”
dans la mémoire de morceaux sélectionnée a mesure que vous les définissez. Il convient cependant
de sauvegarder le multi dans la mémoire de multis de morceaux, tous les réglages et données sont

“entrés” dans la mémoire de morceaux sélectionnée a mesure que vous les définissez.

AVANT DE SAUVEGARDER UN MULTI

Avant d’entrer en mode de sauvegarde, il faut tout d’abord

assigner des sonorités instrumentales aux pistes et régler les autres
parametres de multis de morceaux a sauvegarder pour toutes les
pistes instrumentales nécessaires, a partir du mode de morceaux

“Song”. (REMARQUE: Pour de plus amples informations
concernant les multis de morceaux, voir page 74.)

ACCES A LA FONCTION DE SAUVEGARDE DE

MULTIS

Pour accéder ala fonction de sauvegarde de multis (Store Multi),

appuyer sur STORE, puis sur [F2] (“Multi”).

SELECTION DE L’EMPLACEMENT DE MORCEAU -
Pour sélectionner un emplacement de morceau (entre 01 et
16) ou sauvegarder le multi, utiliser la molette JOG, les
touches INC/DEC ou le pavé numérique.

SAUVEGARDE DU MULTI - Appuyer sur ENTER et le W5/
W7 va vous offrir la possibilité de changer d’avis, en vous
demandant “Are you sure?”. Appuyer sur INC pour confirmer
et sauvegarder le multi ou le morceau ou appuyer sur DEC
pour annuler 'opération.

o SONGoi6L[AYainstThel
STORE:Multi
From = SUEG 16[A%9ainstThel
Set&Press To = SONG EEEREAETTE
LENTER]
dJVoice

REMARQUE: Vous pouvez charger dans le W5/W7 les paramétres de
multis des données de morceaux de format MIDI standard, mais ceux-ci
seront perdus a la mise hors tension de l'appareil, a moins de les avoir
auparavant sauvegardés dans un emplacement de morceau. Afin d’éviter
de perdre accidentellement d’importants parametres de multis, effectucz
régulierement au fil de votre travail lopération de sauvegarde des

multis
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Le mode de sauvegarde de sonorités “Store Voice” permet de sauvegarder la sonorité sélection-
née, y compris tout changement d’édition de sonorités, dans la mémoire de banque de sonorités
interne (1 a 128)

A mesure que Von effectue des changements de réglages de
parametres en mode d’édition des sonorités, les changements se font
sur une copie de la sonorité originale qui est provisoirement conser-
vée dans la mémoire tampon d’édition des sonorités. Les réglages
seront conservés tant que vous commutez entre les fonctions
deédition” et de “comparaison, mais ils seront perdus si vous
sélectionnez une autre sonorité avant de sauvegarder la premiére dans
la mémoire de sonorités interne. Clest pourquuoi il faut toujours
absolument sauvegarder les sonorités importantes créées par
lutilisateur dans la mémoire de banque de sonorités interne avant de
sélectionner une autre sonorite.

REMARQUE: Pour de plus amples informations concernant I'édition des
sonorités, voir le mode de sonorités “Voice” page 108.)

En mode de sauvegarde des sonorités “Store Voice”, les sonorités
choisies, qu'elles soient pré-sélectionnées, Général MIDI ou Internes
peuvent uniquement étre sauvegardées dans la banque de sonorités
interne; la banque interne sera donc automatiquement choisie comme
destination de sauvegarde.

) SONGeiGLAYa i nNSLThE]

STORE:Uoice
From = P128[MacKinley 1
Set&Pres% To = IEERLE.Piano2 ]

Cependant si la sonorité sélectionnée est une sonorité de mor-
ceaux, elle pourra uniquement étre sauvegardée dans la banque de
sonorités de morceaux du multi sélectionné: dans ce cas, la banque de
morceaux sera automatiquement choisie comme destination de
sauvegarde.

o) SONGeRELIN MY LifFeld
]

STORE:Uoice

From = $829{Grit Or9anl
Set&Pr‘es? To = SEMELEP 66°= ]
1 Uoicel

Les sonorités de morceaux sont exclusives a chaque morceau, ce
qui signifie que seules les sonorités du morceau choisi sont accessi-
bles. De méme, comme pour les données de séquences de morceaux,
les données de sonorités se trouvant dans la mémoire de la banque de
sonorités de morceaux ne seront pas conservées apres la mise hors
tension. C'est pourquoi nous vous recommandons de toujours sauvegarder
sur disquette vos données de sonorités de morceaux importantes avant de
mettre le W5/W7 hors tension.

REMARQUE: Pour de plus amples informations concernant les sonorités de
morceaux, reportez-vous au mode Utilitaire, fonction de mémoire de sonorités de
morceaux, page 143.

AVANT LA SAUVEGARDE D’UNE SONORITE
Avant d'entrer en mode de sauvegarde, il faut soit sélectionner
une sonorité a sauvegarder telle quelle dans une banque de
sonorités ou sélectionner une sonorité et 'éditer selon vos gotts a
partir du mode d’édition des sonorités “Voice Edit”.

ACCES A LA FONCTION DE SAUVEGARDE DE
SONORITES

Pour accéder a la fonction de sauvegarde de sonorités, appuyer
sur STORE puis sur [F3] (“Voice”).

o—a) SONGeiELAaAMaAiniItThe]

STORE: Uoice

From = P128[MacKinley 1]
Set&F’r‘es? To = IEBEIE.Piano2 1

SELECTION DE EMPLACEMENT DE SONORITE -
Pour sélectionner un emplacement dans la banque de
sonorités interne (001 a 128) sous lequel sauvegarder la
sonorité, utiliser la molette JOG, les touches INC/DEC ou le
pavé numérique.

SAUVEGARDE DE LA SONORITE - Appuyer sur ENTER
et le W5/W7 va vous offrir la possibilité de changer d’avis, en
vous demandant “Are you sure?”. Appuyer sur INC pour
confirmer et sauvegarder la sonorité ou appuyer sur DEC
pour annuler I'opération.
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Le mode Disque vous permet également de sauvegarder des morceaux dans le format de fichier
MIDI standard 0, mais aussi de charger des séquences enregistrées sur d’autres appareils et
sauvegardées dans des fichiers de formats MIDI Standard 0 et 1, ainsi que dans le format Yamaha

Le mode Disque (Disk) vous permet de sauvegarder sur disquettes 2DD (double densité) de 3,5
pouces vos sonorités originales, vos multis de morceaux ainsi que les données de vos séquences.
Vous pourrez organiser comme bon vous semble la sauvegarde de ces données dans des “fichiers”
de disquette et charger ces fichiers dans la mémoire de sonorités et de morceaux. Ce mode vous
propose également différentes opérations de gestion de vos fichiers: ainsi vous pouvez leur donner
un nouveau nom, les effacer ou encore formater une disquette destinée au systéme opératoire du
W5/W7.

REMARQUE: Si vous tentez d'utiliser une
disquette non formatée, lécran affichera le
message d'erreur “Disk unformatted!”, vous
signalant qu'il vous faut d’abord formater la
disquette.

REMARQUE: Le séquenceur ne
fonctionnera pas si le W5/W7 se trouve en
mode Disque.

ESEQ. (REMARQUE: le “format de fichier MIDI standard”, créé et commercialisé par un
consortium de fabricants de logiciels et d’équipement, permet un transfert en toute facilité de
données de morceau d’un séquenceur a autre, méme s’il s’agit de produits de fabricants différents.
Le W5/W7 recoit deux types de fichiers MIDI standard, connus sous le nom de “format 0” et
“format 1”. Dans les fichiers de format 0, toutes les données de séquencement sont enregistrées
dans une “piste” unique pouvant contenir des données de plusieurs canaux MIDI. Les fichiers de
format 1 vous permettent d’utiliser plusieurs pistes, pouvant contenir chacune les données de
plusieurs caraux. Les données sauvegardées par le W5/W7 dans le format de fichier MIDI standard
seront sauvegardées dans le format de fichier 0. A condition d'utiliser une disquette 2DD (double
densité) de 3,5 pouces formatée selon la norme 9 secteurs et d’'une capacité de 720 kilo-octets, le
W5/W7 peut charger des données sauvegardées dans un des formats mentionnés ci-dessus.)

POUR ACCEDER A ET QUITTER LE MODE DIS-
QUE

Pour accéder au mode Disque, appuyez sur la touche DISK dans
la section Mode du panneau. L'écran affichera le menu principal
des fonctions du mode Disque.

= SONGER@&LIn MY Life]

DISK
> Rename File
»> Delete File

ave o Dis
> Load From Disk > Format Disk

Status Save Load Enam Del Format

Pour quitter le mode Disque depuis son écran de menu, appuyez
une fois sur la touche de sortie EXIT. Pour quitter le mode Disque
depuis une de ses fonctions, appuyez deux fois ou plus sur la
touche EXIT. Vous pouvez également appuyer sur n'importe
quelle touche MODE du panneau.

POUR ACCEDER AUX FONCTIONS DU MODE
DISQUE

Pour accéder aux différentes fonctions du mode Disque, placez le
curseur sur le nom de la fonction que vous souhaitez utiliser et
appuyez sur la touche ENTER, ou appuyez simplement sur la
touche de fonction [F2 a F7] située en face de I'abréviation du
nom de fonction affiché au bas de 'écran. Les fonctions du mode
Disque sont les suivantes:

DISK STATUS - Cette fonction vous permet de controdler le
nombre et les types de fichiers sauvegardés sur la disquette
insérée dans le W5/W7.

SAVE TO DISK - Cette fonction vous permet de sauvegarder
sur la disquette insérée dans le

W5/W7 les sonorités internes et les sonorités de morceaux
ainsi que les données de séquences de morceaux.

LOAD FROM DISK - Cette fonction vous permet de charger
dans la mémoire RAM du W3/W7 les sonorités internes et de
morceaux ainsi que les données de séquences de morceaux de
la disquette insérée dans le W5/W7.

RENAME FILE - Cette fonction vous permet de modifier le
nom de tout fichier de la disquette insérée dans le W5/W7.

DELETE FILE - Cette fonction vous permet deffacer un
fichier de la disquette insérée dans le W5/W7.

FORMAT DISK - Cette fonction vous permet de formater
une disquette 2DD (double densité) de 3,5 pouces de maniere
a la rendre compatible avec le mode opératoire du W5/W7.

REMARQUE: Pour effectuer des opérations dans le mode Disque, il
vous faut insérer une disquette dans le lecteur de disquettes. Si vous
tentez d'effectucr des opérations dans le mode Disque sans avoir inséré
de disquetie, Uécran affichera le message d’erreur “Disk not ready!”.

POUR YOUS DEPLACER DANS LE MODE DISQUE
1l vous sera tres souvent possible lorsque vous vous trouvez dans
une fonction ou sous-fonction donnée du mode Disque de passer
directement a une autre fonction. 1l vous suffira de maintenir
enfoncée la touche de commutation SHIFT tout en appuyant sur
une des touches de fonction [F2 a F7]. Une lettre “S” encadrée
dans une boite noire dans le coté inférieur gauche de I'écran vous
indiquera que vous pouvez passer a une autre fonction. Pour
retourner au menu principal du mode Disque depuis une
fonction, appuyez une fois ou plus sur la touche de sortie EXIT,
ou encore appuyez sur la touche DISK dans la section Mode du
panneau. Vous pouvez charger a partir de et sauvegarder sur
disquette depuis le répertoire de fichiers.
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¢ SELECTIONNER DES FICHIERS

Chaque fois que vous sélectionnerez une fonction de chargement
ou de sauvegarde dans le mode Disque, l'écran affichera un menu
de sous-fonctions reprenant les types de fichiers. Ce menu vous
vous permet de sélectionner le type de fichier de données a
sauvegarder sur ou a charger a partir de la disquette insérée.

SONGa@ELIn MY Lif2]

F.:ﬂ
DISK:Save to Disk

> All Dats > SMF
7> Voice

ond+loice

h Al 1Sond 15+0 SMF Uoice

Pour sélectionner les différents types de fichiers, placez le curseur
sur le nom du type de fichier que vous souhaitez charger ou
sauvegarder et appuyez sur la touche ENTER. Vous pouvez
également simplement appuyer sur la touche de fonction [F2 a
F6] située en face de I'abréviation du nom de fonction affiché au
bas de I'écran.

TYPES DE FICHIERS- Une fois un fichier sauvegardé, le
type de fichier est représenté par un point suivi d’'un code a
trois caracteres. Cette représentation suit le nom du fichier
dans le répertoire de fichiers. Les types de fichiers sont les
suivants: '

ALL DATA (.A1A) - Un fichier de données du type “All
Data” (toutes les données) contient toutes les données de
multis du W5/W7, y compris les 16 morceaux (données
de séquenceur et/ou de multis) ainsi que les banques de
sonorités de morceaux qui les accompagnent . Les
données “All” sont chargées a partir de et stockées dans
une banque de morceaux internes (01 & 16) RAM.

1 SONG (.A1Q) - Un fichier de données du type “1
Song” contient un seul morceau (données de séquenceur
et/ou de multis). Les données “1 Song” sont chargées a
partir de et stockées dans une banque de morceaux
internes (01 a 16) RAM.

1 SONG + VOICE (.A1S) - Un fichier de données du
type “1 Song + Voice” contient un seul morceau (données
de séquenceur et/ou de multis) ainsi que les 128 sonorités
de morceaux et les 2 sonorités rythmiques de morceaux
qui 'accompagnent. Les données “1 Song + Voice” sont
chargées a partir de et stockées dans une banque de
morceaux internes (01 a 16) RAM.

ESEQ/SMF (.MID) - Un fichier de données du type
“SMF” (de format MIDI standard) contient un morceau
(données de séquenceur et de multis) sauvegardé dans le
format de fichier MIDI standard. Les fichiers du type SMF
vous permettent des échanges de données en toute facilité
entre des instruments produits par différents fabricants,
mais adoptant tous la norme SMF. Les données SMF sont
chargées a partir de et stockées dans une mémoire de
morceaux interne (01 a 16) RAM. (REMARQUE: Le W5/
W7 peut recevoir des fichiers sauvegardés dans un des
formats SMF (format O ou format 1), mais ne peut
toutefois sauvegarder des fichiers que dans le format de
fichier MIDI standard 0.) Un fichier de données “ESEQ”
contient un seul morceau sauvegardé dans le format
Yamaha ESEQ (compatible avec le SY99, le SY77, e Piano
Player et le Clavinoma; toutefois, les disquettes de
données musicales commercialisées pour le Piano Player
et le Clavinoma ne pourront étre utilisées avec le W5/
W7). Les fichiers ESEQ peuvent étre chargés sans
probleme dans le W5/W7; toutefois, ce dernier ne peut
sauvegarder des fichiers dans le format ESEQ.

YOICE (.A1V) - Un fichier de données du type “Voice”
contient une banque compléte de 128 sonorités normales
internes ainsi que 2 sonorités rythmiques internes. Les
données “Voice” sont sauvegardées sur disquette dans une
banque complete de sonorités internes disposant
d'éléments, mais peuvent étre chargées a nouveau dans la
banque de sonorités internes. 1l est possible de charger
toutes les sonorités en une fois (y compris les sonorités
rythmiques), ou encore une sonorité dans un numeéro de
sonorité interne déterminé (a I'exception des sonorités
rythmiques internes). Si 'emplacement de mémoire du
morceau de destination dispose d’une banque de
sonorités de morceaux, vous pouvez y chargez la banque
de sonorités internes ou charger une seule sonorité
interne dans un numeéro de sonorité de morceau.

SELECTIONNER UN TYPE DE FICHIER

Pour sélectionner un type de fichier, placez le curseur sur le nom
de la sous-fonction du type de fichier que vous souhaitez utiliser
et appuyez sur la touche ENTER. Vous pouve: également
simplement appuyer sur la touche de fonction [F2 a F6] située en
face de l'abréviation du nom du type de fichier affiché au bas de
Pécran. Si l'opération est une fonction du type “donner un
nouveau nom” ou “sauvegarder”, vous pouvez donner un nom au
fichier et controler le répertoire de fichiers pour ensuite exécuter
les opérations depuis I'une des sous-fonctions.

Mo SONGE@ELINn MY Lifel
DISK:Save to Disk

Uoice From = INTERNAL
Set&Press To = FILE:[NEW_UCE 1
[ENTER]

Name Dir

DONNER UN NOM AU FICHIER - Pour donner un nom 2
un fichier, appuyez sur la touche [F7] (“Name”). L'écran de
nom (Name) est ainsi activé et vous permet d’entrer un nom
de 8 caracteres pour le fichier.

o SONGe@SLIn MY LifFel

L MCE ]
TE ! HEXR (H—g > {3
IJKLMROPRRSTUVWXYZ

r- 2
om
=

LSPLC]  + > | Name |

Pour donner un nom au fichier, placez le curseur a fleche vers
le bas a T'aide des touches [F4] et [F5]. Sélectionnez les
caracteres souhaités a 'aide des touches de curseur, des
touches INC/DEC ou de la molette JOG. Vous pouvez entrer
un espace en appuyant sur la touche [F3] (“[SPC]™). Une fois
le nom entré, vous pouvez soit retourner 2 I'écran de sous-
fonctions en appuyant une fois sur la touche de sortie EXIT,
soit continuer et terminer l'opération en appuyant sur la
touche ENTER.

REPERTOIRE DE FICHIERS - Le répertoire de fichiers
(File Directory) affiche par type (c’est-a-dire selon le type de
fichier de morceaux, le type de fichier de sonorités, etc.) la
liste des fichiers contenus sur la disquette insérée dans le W5/
W7. Le type de fichier affiché dépend de la sous-fonction du
mode Disque dans laquelle vous vous trouvez (c'est-a-dire
“All” (toutes les données), Voice (sonorités), etc.). Vous
pouvez effectuer I'opération souhaitée a partir du répertoire
de fichiers.
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L'exemple ci-dessous vous montre une liste incomplete des
fichiers des types de sonorités. Cette liste est accessible en
appuyant sur la touche [F8] (“Dir”) depuis n'importe quelle
sous-fonction du fichier “Voice” des types de sonorités.

REMARQUE: Lindication “.A1V” suivant le nom de fichier correspond
au code du systeme opératoire du W5/W7. Ce code est propre aux
fichiers de types de sonorités.

0 SONGuR&slLIn MY Life]
FILE Directory |
a1 W B5: PARAZ Al
a2: HE| . a5: .
B3: HPN_1SNG.A1Q ar: .
g4: PORAI™ .0l B8k .

La liste affichée sur I'écran ne comprendra pas plus de huit
fichiers simultanément, mais vous pouvez passer en revue
tous les fichiers contenus dans la liste grace aux touches de
curseur. L'écran affichera au fil de votre lecture tous les
fichiers contenus sur la disquette.

REMARQUE: Le nombre de fichiers que vous pouvez sauvegarder sur
la disquette dépend de la quantité de données musicales des fichiers. Il va
de soi que de longs morceaux occupent davantage de place sur la
disquette.

La fonction Disk Status (statut de la disquette) vous permet de contrdler le nombre et les types
de fichiers sauvegardés sur la disquette insérée dans le W3/W7.

e SONGeE@SCIn MY Lifel

DISK

> Rename File
ave 1o lig > Delete File
> Load From Disk > Format Disk

Status Save Toad Enam Tel Format

POUR ACCEDER A LA FONCTION DISK STATUS
Pour accéder a la fonction Disk Status depuis I'écran de menu
principal du mode Disque, placez le curseur sur “Disk Status” et
appuyez sur la touche ENTER. Vous pouvez également simple-
ment appuyer sur la touche [F2] (“Status™).

o SONGE@SLIn MY Lifeld
DISK:Status

Total 12 Files Al]l Data 2 Files

Used 267kBytes 1 Sond 5 Files
Free 446kBytes 1 Son9+Uoice 4 Files

ALL DATA - Vous indique combien de fichiers contenant 16
multis de morceaux (avec données de séquenceur et/ou de
multis) ainsi que les banques de sonorités de morceaux et de
sonorités rythmiques de morceaux accompagnant ces fichiers
la disquette insérée dans le W5/W7 comprend.

1 SONG - Vous indique combien de fichiers contenant les
données de multis d’'un seul morceau (séquenceur et/ou
multis) la disquette insérée dans le W5/W7 comprend.

1 SONG + VOICE - Vous indique combien de fichiers
contenant les données de multis d’'un seul morceau
(séquenceur et/ou multis) ainsi que les banques de sonorités
de morceaux et de sonorités rythmiques de morceaux
accompagnant ces fichiers la disquette insérée dans le W5/W7
comprend.

VOICE - Vous indique combien de fichiers contenant les
données de banques de sonorités la disquette insérée dans le
WS5/W7 comprend.
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La fonction Save To Disk (sauvegarde sur disquette) vous permet de déterminer le type de
données que vous souhaitez sauvegarder et de les stocker dans un fichier sur disquette.

0 SONGo@ELIn MY Lifeld

DISK
> Digk Status
0a rom Dis

2 Rename File
> Delete File
» Format Disk

Status Save Load Rham Tel Formal

REMARQUE: Si la disquette ne dispose pas d’assez de mémoire disponible pour
effectuer une opération de sauvegarde, I'écran affichera le message d’erreur “Disk
Full?”. Dans ce cas, vous pouvez soit effacer certains fichiers de la disquette, soit
insérér une nouvelle disquette dans le W5/W7. Si vous tentez de sauvegarder un
fichier portant un nom identique a un nom de fichier déja existant sur la disquette, le
W5/W7 affichera le message “Overwrite?”, vous demandant si vous souhaitez écraser
le fichier déja existant. Veillez a ne pas effacer ou écraser de fichiers de données
importantes, car ceux-ci seront effacés sur la disquette.

POUR ACCEDER A LA FONCTION SAVE TO DISK
Pour accéder au sous-menu de fonctions Save to Disk depuis
I'écran de menu principal du mode Disque, placez le curseur sur
“Save To Disk” et appuyez sur la touche ENTER. Vous pouvez
également simplement appuyer sur la touche [F3] (“Save™).

e SONGE@SLIn MY Lifed
DISK:Save to Disk
2 ShF

> Uoice

ong
> 1 Song+loice

g AT 1Song 1S+U SHAF Uoice

SAUVEGARDER TOUTES LES DONNEES - Vous permet
de sauvegarder dans un fichier de disquette les 16 morceaux
(donnges de séquenceur et/ou de multis) ainsi que les
banques de sonorités de morceaux et de sonorités rythmiques
de morceaux les accompagnant. Pour sélectionner la sous-
fonction “Save All” (sauvegarder toutes les données) depuis
Pécran de sous-menu Save to Disk, placez le curseur sur “All
Data” et appuyez sur la touche ENTER. Vous pouvez
également simplement appuyer sur la touche [F2] (*All").
L'écran Save to Disk/All Data apparaitra alors.

B SONGERELIn MY Life]
DISK:iSave to Disk

All Data
Set&Pressg
[ENTEE]

To = FILE: LTNEW_ALL 1
Name Dir

REPERTOIRE DE FICHIERS - Pour visionner le
répertoire de fichiers et controler quels fichiers de type
“All” (toutes les données) la disquette insérée dans le W5/
W7 contient déja avant de sauvegarder votre nouveau
fichier, appuyez sur la touche [F8] (“Dir”). Aprés avoir
controlé le répertoire de fichiers, appuyez une fois sur la
touche de sortie EXIT pour retourner a 'écran Save to
Disk/AlL

DONNER UN NOM AU FICHIER - Pour donner un
nom au fichier avant de le sauvegarder, appuyez sur la
touche [F7] (“Name”) depuis 'écran Save to Disk/All
Placez le curseur a Faide des touches [F4] et [F5] et
sélectionnez les caracteres a I'aide des touches de curseur,
INC/DEC ou de la molette JOG. Pour retourner a 'écran
Save to Disk/All, appuyez sur la touche EXIT.

SAUVEGARDER TOUTES LES DONNEES SUR DIS-
QUETTE - Apres avoir donné un nom au nouveau fichier,
vous pouvez lancer l'opération de sauvegarde directement
depuis Pécran Name. (Vous pouvez également effectuer la
sauvegarde en appuyant sur la touche ENTER depuis 'écran
Save to Disk/All ou depuis le répertoire de fichiers.) L'écran
affichera le message “Executing...”, vous indiquant que
Popération de sauvegarde est en cours. Lorsque la sauvegarde
est effectuée, I'écran affichera le message “Completed!”.

SAUVEGARDER 1 MORCEAU - Vous permet de sauvegar-
der 1 seul morceau (données de séquenceur et/ou de multis)
dans un fichier sur disquette. Pour sélectionner la sous-
fonction “1 Song” (1 morceau) depuis l'écran de sous-menu
Save to Disk, placez le curseur sur “1 Song” et appuyez sur la
touche ENTER. Vous pouvez également simplement appuyer
sur la touche [F3] (*1Song”). L'écran Save to Disk/1 Song
apparaitra alors.

e SONGE@ELIn MY Li fel
DISK:Save to Disk |

1 Son92 From = SDEG [SIEN
Set&Press To = FILE: [KF-HAITI]
[ENTER]

Name Dir

Choisissez le morceau que vous souhaitez sauvegarder a l'aide
de la molette JOG, des touches INC/DEC ou du pavé
numeérique. Pour retourner a 'écran Save to Disk/1Song,
appuyez sur la touche de sortie EXIT.

REPERTOIRE DE FICHIERS - Pour visicnner le
répertoire de fichiers et controler quels fichiers de type “1
Song” (1 morceau) la disquette insérée dans le W5/W7
contient déja avant de sauvegarder votre nouveau fichier,
appuyez sur la touche [F8]. Apres avoir contrdlé le
répertoire de fichiers, appuyez une fois sur la touche de
sortie EXIT pour retourner a écran Save to Disk/1 Song.

DONNER UN NOM AU FICHIER - Pour donner un
nom au fichier avant de le sauvegarder, appuyez sur la
touche {F7] (“Name”) depuis I'écran Save to Disk/1 Song.
Placez le curseur a l'aide des touches {F4] et [F5] et
sélectionnez les caractéres & l'aide des touches de curseur,
INC/DEC ou de la molette JOG. Une fois le nom entré,
appuyez une fois sur la touche EXIT pour retourner a
l'écran Save to Disk/1 Song,

SAUVEGARDER 1 MORCEAU SUR DISQUETTE - Apres
avoir donné un nom au nouveau fichier, vous pouvez lancer
l'opération de sauvegarde directement depuis I'écran Name.
(Vous pouvez également effectuer la sauvegarde en appuyant
sur la touche ENTER depuis 'écran Save to Disk/1 Song ou
depuis le répertoire de fichiers.) L'écran affichera le message
“Executing...”, vous indiquant que l'opération de sauvegarde
est en cours. Lorsque la sauvegarde est effectuée, l'écran
affichera le message “Completed!”.
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SAUVEGARDER 1 MORCEAU + SONORITES - Vous
permet de sauvegarcer dans un fichier de disquette 1 seul
morceau (séquenceur et/ou multis) ainsi que les banques de
sonorités de morceaux et de sonorités rythmiques de
morceaux 'accompagnant. Pour sélectionner la sous-fonction
“1 Song +Voice” (1 morceau + sonorités) depuis I'écran de
menu Save to Disk, placez le curseur sur “1 Song+Voice™ et
appuyez sur la touche ENTER. Vous pouvez également
simplement appuyer sur la touche [F4]} (“15+V"). L'écran Save
to Disk/1 Song + Voice apparaitra alors.

W SONGe@SCLANnG I Love]l
DISK:Save to Disk

1Sond+lUce From =
Set&Press To = FILE: [NEW_15&U1]

[ENTER]
Name Dir

Choisissez le morceau que vous souhaitez sauvegarder a l'aide
de la molette JOG, des touches INC/DEC ou du pavé
numérique (01 a 16). Appuyez ensuite sur la touche ENTER.

REPERTOIRE DE FICHIERS - Pour visionner le
répertoire de fichiers et contréler quels fichiers de type “1
Song+Voice” (1 morceau + sonorités) la disquette insérée
dans le W5/W7 contient déja avant de sauvegarder votre
nouveau fichier, appuyez sur la touche [F8]. Apres avoir
controlé le répertoire de fichiers, appuyez une fois sur la
touche de sortie EXIT pour retourner a écran Save to
Disk/1 Song + Voice.

DONNER UN NOM AU FICHIER - Pour donner un
nom au fichier avant de le sauvegarder, appuyez sur la
touche |F7] (“Name”). Placez le curseur a l'aide des
touches [F4] et [F5] et sélectionnez les caracteres a l'aide
des touches de curseur, INC/DEC ou de la molette JOG.
Pour retourner a I'écran Save to Disk/1 Song + Voice,
appuyez sur la touche de sortie EXIT.

SAUVEGARDER 1 MORCEAU + SONORITES SUR
DISQUETTE - Apres avoir donné un nom au nouveau
fichier, vous pouvez lancer l'opération de sauvegarde
directement depuis 'écran Name. (Vous pouvez également
effectuer la sauvegarde en appuyant sur la touche ENTER
depuis P'écran Save to Disk/1 Song + Voice ou depuis le
répertoire de fichiers.) L’écran affichera le message
“Executing...”, vous indiquant que l'opération de sauvegarde
est en cours. Lorsque la sauvegarde est effectuée, 'écran
affichera le message “Completed!”.

Choisissez le morceau que vous souhaitez sauvegarder a l'aide
de la molette JOG, des touches INC/DEC ou du pavé
numeérique.

REPERTOIRE DE FICHIERS - Pour visionner le
répertoire de fichiers et controler quels fichiers de type
“SMF” (fichiers MIDI standard) la disquette insérée dans
le W5/W7 contient déja avant de sauvegarder votre
nouveau fichier, appuyez sur la touche [F8]. Aprés avoir
controlé le répertoire de fichiers, appuyez une fois sur la
touche de sortie EXIT pour retourner a I'écran Save to
Disk/SMF.

DONNER UN NOM AU FICHIER - Pour donner un
nom au fichier avant de le sauvegarder, appuyez sur la
touche [F7] (“Name”). Placez le curseur a l'aide des
touches [F4] et [F5] et sélectionnez les caracteres a l'aide
des touches de curseur, INC/DEC ou de la molette JOG.
Pour retourner  'écran Save to Disk/SMF, appuyez sur la
touche EXIT.

SAUVEGARDER DES FICHIERS MIDI STANDARD SUR
DISQUETTE - Aprés avoir donné un nom au nouveau
fichier, vous pouvez lancer I'opération de sauvegarde
directement depuis I'écran Name. (Vous pouvez également
effectuer la sauvegarde en appuyant sur la touche ENTER
depuis l'écran Save to Disk/SMF ou depuis le répertoire de
fichiers.) L'écran affichera le message “Executing...”, vous
indiquant que Popération de sauvegarde est en cours. Lorsque
la sauvegarde est effectuée, l'écran affichera le message
“Completed!”.

SAUVEGARDER DES SONORITES - Vous permet de
sauvegarder dans un fichier de disquette toutes les données de
la banque de sonorités internes (128 sonorités normales et 2
sonorités rythmiques) en une fois. Pour sélectionner la sous-
fonction “Voice” (sonorités) depuis 'écran de menu Save to
Disk, placez le curseur sur “Voice” et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche [F6] (“Voice™). L'écran Save to Disk/Voice apparaitra
alors.

e SONGeR?LThinds We 3
DISK:Save to Disk

Uoice From

INTERNAL
FILE: [NEW_UCE 1]

Set&Press To
[ENTER]

Name Dir

REMARQUE: Si le morceau sélectionné contient des sonorités de
morceau, le W5/W7 les sauvegardera automatiquement dans le fichier.
Si par contre le morceau sélectionné ne contient pas de sonorités de
morceau, le W5/W7 effectuera automatiquement une copie de la banque
de sonorités internes dans la banque de sonorités de morceaux et les
sauvegardera.

SAUVEGARDER DES FICHIERS MIDI STANDARD -
Vous permet de sauvegarder sur disquette un seul morceau
(données de séquenceur et de multis) dans un fichier de
format MID! standard (format 0). Pour sélectionner la sous-
fonction “SMF” (fichiers MIDI standard) depuis 'écran de
menu Save to Disk, placez le curseur sur “SMF” et appuyez
sur la touche ENTER. Vous pouvez également simplement
appuyer sur la touche [F3] (“SMF”). L’écran Save to Disk/SMF
apparaitra alors.

e SONGa@7LThinds We 3
DISK:Save to Disk |

SHF From = N
Set&Pregs To = FILE: [THINGSHE]
[ENTEE]

Name Dir

REPERTOIRE DE FICHIERS - Pour visionner le
répertoire de fichiers et controler quels fichiers de type
“Voice” (sonorités) la disquette insérée dans le W5/W7
contient déja avant de sauvegarder votre nouveau fichier,
appuyez sur la touche [F8]. Apres avoir controlé le
répertoire de fichiers, appuyez une fois sur la touche de
sortie EXIT pour retourner a l'‘écran Save to Disk/Voice.

DONNER UN NOM AU FICHIER - Pour donner un
nom au fichier avant de le sauvegarder, appuyez sur la
touche [F7] (“Name”). Placez le curseur 4 l'aide des
touches [F4] et [F5] et sélectionnez les caracteres a l'aide
des touches de curseur, INC/DEC ou de la molette JOG.
Pour retourner a I'écran Save to Disk/Voice, appuyez sur
la touche EXIT.

SAUVEGARDER DES SONORITES SUR DISQUETTE -
Apres avoir donné un nom au nouveau fichier, vous pouvez
lancer Popération de sauvegarde directement depuis I'écran
Name. (Vous pouvez également effectuer la sauvegarde en
appuyant sur la touche ENTER depuis I'écran Save to Disk/
Voice ou depuis le répertoire de fichiers.) L'écran affichera le
message “Executing...”, vous indiquant que 'opération de
sauvegarde est en cours. Lorsque la sauvegarde est effectuée,
Técran affichera le message “Completed!”.
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quel fichier d'une disquette charger dans le W5/W7 et, selon le type de fichier, ou le charger.

La fonction Load From Disk (chargement a partir d'une disquette) vous permet de déterminer REMARQUE: Quel que soit le type de

Emn SONGERTPLThings We 1

DISK

2 Digk Status 7 Rename File
> Save To Disk 2 Delete File
> Load From Disk ?» Format Disk

Status Save Load Rnam Del Format

POUR ACCEDER A LA FONCTION LOAD FROM
DISK

Pour accéder au sous-menu de fonctions Load From Disk depuis
I'écran de menu principal du mode Disque, placez le curseur sur
“Load From Disk” et appuyez sur la touche ENTER. Vous pouvez
également simplement appuyer sur la touche [F4] (“Load™).

Mo SONGU@7LThinds We 3

DISK!lLoad from Disk

2 ESEQ/SMF
Uoice

ong
> 1 Song+loice

g AT 1Sond T5+U SAF Uoice

CHARGER TOUTES LES DONNEES - Vous permet de
charger dans la banque de mémoire de morceaux internes un
fichier contenant les 16 morceaux (données de séquenceur et/
ou de multis) ainsi que les banques de sonorités de morceaux
et de sonorités rythmiques de morceaux les accompagnant.
Pour sélectionner la sous-fonction “All Data” (toutes les
données) depuis I'écran de sous-menu Load From Disk,
placez le curseur sur “All” et appuyez sur la touche ENTER.
Vous pouvez également simplement appuyer sur la touche
[F2] (*All"). L’écran Load from Disk/All Data apparaitra alors.

oo SONGeR@7LThings We 3
DISK:Load from Disk ]

All Data
From= FILE [SheEh=0e32 (0

Set&Press

LENTER]

Dir

REPERTOIRE DE FICHIER - Pour visionner depuis le
répertoire de fichiers la liste des fichiers de type “All”
contenus sur la disquette insérée dans le W5/W7,
appuyez sur la touche [F8] (“Dir”).

SELECTIONNER UN FICHIER - Sélectionnez le fichier
que vous souhaitez charger au moyen de la molette JOG,
des touches INC/DEC ou du pavé numérique. (REMAR-
QUE: Si la disquette ne contient qu'un seul fichier,
l'option de sélection n'est bien sur pas disponible.)

Sfichier que vous chargiez dans le W5/W7,
ce dernier remplace et efface
irrémédiablement les dorinées existantes.
Aussi, veillez a sauvegarder vos données
musicales importantes sur disquette avant
de charger un fichier dans le W5/W7.

REMARQUE: Si vous sélectionnez
accidentellement un mauvais type de fichier
sur une disquette, le W5/W7 affichera le
message d’erreur “File not found!”.

CHARGER TOUS LES FICHIERS D'UNE DISQUETTE -
Vous pouvez lancer I'opération de chargement depuis l'écran
Load from Disk/All ou depuis le répertoire de fichiers en
appuyant sur la touche ENTER. Le W5/W7 vous donne la
possibilité d’annuler I'opération en affichant le message de
confirmation “Are You Sure?”. Appuyez sur la touche DEC
pour annuler Popération ou sur la touche INC pour charger
les fichiers depuis la disquette. L'écran affichera le message
“Executing...”, vous indiquant que Fopération de chargement
est en cours. Lorsque le chargement est effectué, l'écran
affichera le message “Completed!”.

CHARGER 1 MORCEAU - Vous permet de charger un
fichier contenant un seul morceau (données de séquenceur et/
ou de multis) dans un emplacement de mémoire de morceau
(1 4 16). Pour s¢lectionner la sous-fonction “1 Song” (1
morceau) depuis I'écran de sous-menu Load From Disk,
placez le curseur sur “1 Song” et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche {F3) (“1Song™). L’écran Load from Disk/1 Song
apparaitra alors.

W > Uoice
ong+lUoice

e SONGU@7LThings We 3]

DISK:Load from Disk
> All Data > ESEQ/SMF

5

ATl 15ond 15+U SHF Uoice

SELECTIONNER UN FICHIER - Sélectionnez le fichier
que vous souhaitez charger en placant le curseur sur le
champ “From = FILE” et au moyen de la molette JOG, des
touches INC/DEC ou du pavé numérique.

o) SONGeRSCand I Lovel
DISK:Load from Disk

1 Son9 Fraom = FII;E B1:AGRINST

Set&Press To = SONG [E=HTE
LENTER]

Dir
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SELECTIONNER UN EMPLACEMENT - Sélectionnez
I'emplacement de mémoire de morceau dans lequel vous
souhaitez charger le fichier en placant le curseur sur le
champ “To = SONG” et au moyen de la molette JOG, des
touches INC/DEC ou du pavé numeérique.

REPERTOIRE DE FICHIERS - Pour visionner depuis le
répertoire de fichiers la liste des fichiers de type “1 Song”
contenus sur la disquette insérée dans le W5/W?7,
appuyez sur la touche [F8] (“Dir”).

CHARGER 1 MORCEAU DEPUIS UNE DISQUETTE -
Vous pouvez lancer l'opération de chargement depuis I'écran
Load from Disk/1 Song ou depuis le répertoire de fichiers en
appuyant sur la touche ENTER. Le W5/W7 vous donne la
possibilité d’annuler I'opération en affichant le message de
confirmation “Are You Sure?”. Appuyez sur la touche DEC
pour annuler Popération ou sur la touche INC pour charger le
fichier depuis la disquette. L'écran affichera le message
“Executing...”, vous indiquant que 'opération de chargement
est en cours. Lorsque le chargement est effectué, 'écran
affichera le message “Completed!”.

REMARQUE: Charger un fichier de type “1 Song” (1 morceaw) dans un
emplacement de multis de morceaux effacera toute donnée de sonorités
de morceaux présente dans la mémoire de multis de morceaux.

CHARGER 1 MORCFAU + SONORITES DEPUIS UNE
DISQUETTE - Vous pouvez lancer l'opération de charge-
ment depuis I'écran Load from Disk/1 Song + Voice ou depuis
le répertoire de fichiers en appuyant sur la touche ENTER. Le
W5/W7 vous donne la possibilité d’'annuler I'opération en
affichant le message de confirmation “Are You Sure?”.
Appuyez sur la touche DEC pour annuler 'opération ou sur la
touche INC pour charger le fichier depuis la disquette.
Lécran affichera le message “Executing...”, vous indiquant
que l'opération de chargement est en cours. Lorsque le
chargement est effectué, 'écran affichera le message
“Completed!”.

CHARGER UN FICHIER ESEQ/SMF - Vous permet de
charger un fichier contenant un seul morceau (données de
séquenceur et de multis) sauvegardé dans le format Yamaha
ESEQ ou dans un des formats MIDI standard (format 0 ou
format 1) dans un emplacement de mémoire de morceaux (01
4 16). Pour sélectionner la sous-fonction “ESEQ/SMF” (ESEQY/
MIDI standard) depuis l'écran de sous-menu Load From Disk,
placez le curseur sur “ESEQ/SMF” et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche [F5] (*SMF™). L'écran Load From Disk/ESEQ/SMF
apparaitra alors.

CHARGER 1 MORCEAU + SONORITES - Vous permet de
charger un fichier contenant un seul morceau (séquenceur et/
ou multis) ainsi que les banques de sonorités de morceaux et
de sonorités rythmiques de morceaux les accompagnant dans
un emplacement de mémoire de morceau (01 a 16). Pour
sélectionner la sous-fonction “1 Song+Voice” (1 morceau +
sonorités) depuis 'écran de sous-menu Load From Disk,
placez le curseur sur “1 Song+Voice” et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche [F4] (“15+V™). L'écran Load from Disk/1 Song + Voice
apparaitra alors.

e SONGROSTAnd I Loweld

DISK:Load from Disk
> Al]l Data > ESEGQ-SMF
> 1 Sond Uoice

Sor+Hllo1ios

|8

ALl 15ond 15+J SMF Uoice

SELECTIONNER UN FICHIER - Sélectionnez le fichier
que vous souhaitez charger en placant le curseur sur le
champ “From = FILE” et au moyen de la molette JOG, des
touches INC/DEC ou du pavé numérique.

Koo SONGR@ESLInit Sond J
DISK:Load from Disk i

1Song+Uce From = FII;E B4:ROCK15&U
To = SONG [sEH

Set&Press
[ENTER]

SELECTIONNER UN EMPLACEMENT - Sélectionnez
'emplacement de mémoire de morceau dans lequel vous
souhaitez charger le fichier en placant le curseur sur le
champ “To = SONG” et au moyen de la molette JOG, des
touches INC/DEC ou du pavé numérique.

REPERTOIRE DE FICHIERS - Pour visionner depuis le
répertoire de fichiers la liste des fichiers de type “1
Song+Voice” contenus sur la disquette insérée dans le
W5/W7, appuyez sur la touche [F8] (“Dir").

Eo—a SONGoeELInit Sond 1
DISK:Load from Disk
> Al] Data Wmm—
> 1 Song o1ce
> 1 Song+Uoice
B AT 15on3 15+ SFF Uoice

SELECTIONNER UN FICHIER - Sélectionnez le fichier
que vous souhaitez charger en placant le curseur sur le
champ “From = FILE” et au moyen de la molette JOG, des
touches INC/DEC ou du pavé numérigue.

== SONGoiZLInit Sond 3
DISK:Load from Disk

ESER-SMF From FI%E B4 : LONGROAD. MID
Set&Press To SONG
LENTER]

SELECTIONNER UN EMPLACEMENT - Sélectionnez
Templacement de mémoire de morceau dans lequel vous
souhaitez charger le fichier en plagant le curseur sur le
champ “To = SONG” et au moyen de la molette JOG, des
touches INC/DEC ou du pavé numérique.

REPERTOIRE DE FICHIERS - Pour visionner depuis le
répertoire de fichiers la liste des fichiers de type “ESEQ/
SMF” contenus sur la disquette insérée dans le W5/W7,
appuyez sur la touche [F8] (“Dir”).

CHARGER DES FICHIERS ESEQ/SMF DEPUIS UNE
DISQUETTE - Vous pouvez lancer l'opération de charge-
ment depuis I'écran Load from Disk/ESEQ/SMF ou depuis le
répertoire de fichiers en appuyant sur la touche ENTER. Le
W5/W7 vous donne la possibilité d'annuler I'opération en
affichant le message de confirmation “Are You Sure?”.
Appuyez sur la touche DEC pour annuler l'opération ou sur la
touche INC pour charger le fichier depuis la disquette.
Lécran affichera le message “Executing...”, vous indiquant
que lopération de chargement est en cours. Lorsque le
chargement est effectué, I'écran affichera le message
“Completed!”.
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REMARQUE: Le répertoire de fichiers affichera tous les noms de
fichier, méme s'il ne s’agit pas de fichiers W5/W7, ESEQ ou de format
MIDI standard. Vous pouvez sélectionner les fichiers de types ESEQ et
MIDI standard et les charger dans le W5/W7, mais a chaque tentative
de chargement de fichiers d’autres systemes opératoires, le W5/W7
affichera le message d’erreur “llegal file!”, vous signalant que vous ne
pouvez charger de fichier étranger au W5/W7.

CHARGER DES SONORITES - Vous permet de charger
dans la banque interne ou dans une banque de sonorités de
morceaux un fichier contenant des sonorités.

Pour sélectionner la sous-fonction “Voice” {(sonorités) depuis
I'écran de sous-menu Load From Disk, placez le curseur sur
“Voice” et appuyez sur la touche ENTER. Vous pouvez
également simplement appuyer sur la touche F6] (“Voice”).
Lécran Load from Disk/Voice apparaitra alors.

Vous pouvez accéder aux fichiers de type “Voice” depuis
Iécran Load from Disk/Voice et charger une seule sonorité
(uniquement une sonorité normale) dans un seul emplace-
ment de mémoire de sonorités internes ou de morceaux (si
I'emplacement de mémoire de morceaux sélectionné com-
porte une banque de sonorités de morceaux). Vous pouvez
charger un ensemble complet de 128 sonorités normales et de
2 sonorités rythmiques dans la banque de sonorités internes
ou dans une banque de sonorités de morceaux.

CHARGER TOUTES LES SONORITES - Pour pouvoir
charger toutes les sonorités (sonorités normales et rythmi-
ques) d’un fichier de type “Voice” dans la banque de sonorités
internes ou dans une banque de sonorités de morceaux, il
vous faut sélectionner “all voice” (toutes les sonorités).

o SONGol120Init Sond ]

DISKiLoad from Disk

> All Data > ESEQ-SMF
2> 1 Sond .  Doice

> 1 Sond+Uoice

ALl 1Sond 15+0 SHF Uoice

SELECTIONNER UN FICHIER - Sélectionnez le fichier
“Voice™ que vous souhaitez charger en placant le curseur
sur le champ “From = FILE” et au moyen de la molette
JOG, des touches INC/DEC ou du pavé numeérique.

SELECTIONNER UNE BANQUE INTERNE OU DE
MORCEAUKX - Si vous souhaitez charger le fichier dans
la banque de sonorités internes, placez le curseur sur le
champ “To = " et sélectionnez “INTERNAL” a l'aide de la
molette JOG ou des touches INC/DEC. Si par contre vous
souhaitez charger le fichier dans une banque de sonorités
de morceaux (01 a 16), placez le curseur sur le champ
“To= " et sélectionnez “SONG” a l'aide de la molette
JOG ou des touches INC/DEC. Appuyez ensuite une fois
sur la touche de curseur vers la droite de maniére a placer
le curseur sur le champ de sélection de la mémoire de
sonorités de morceaux.

Mo SONGRiZ[INit Sond 3
DISK:Load from Disk J

FILE B1:AMBIENT
¥ al% voice

Uoice From
Set&Press To
[ENTER]

Dir

Sélectionnez 'emplacement de mémoire des sonorités de
morceaux (01 a 16) a Iaide de la molette JOG, des
touches INC/DEC ou du pavé numérique.

CHARGER UNE SEULE SONORITE - Vous permet de
charger une seule sonorité {(seulement une sonorité normale)
d'un fichier de type “Voice” dans un emplacement de
mémoire de sonorités internes ou de morceaux.

SELECTIONNER UN FICHIER - Sélectionnez dabord
un fichier dans le champ “From = FILE”. Placez ensuite le
curseur sur le champ “all voice” et choisissez une sonorité
(001 a 128) depuis le fichier en utilisant ia molette JOG,
les touches INC/DEC ou le pavé numérique.

e SONGeil2CInit Sond 3
DISKiLoad from Disk

Uoice From = FILE B1:AMBIENT
¥ B82{Cymbalon 1
? To = INTERNAL

ir

SELECTIONNER UNE SONORITE INTERNE OU DE
MORCEAU - Si vous souhaitez charger la sonorité dans
une mémoire de sonorités internes, placez le curseur sur
le champ “To = ” et sélectionnez “INTERNAL” en vous
aidant de la molette JOG ou des touches INC/DEC. Si par
contre vous désirez charger la sonorité dans une mémoire
de sonorités de morceaux, placez le curseur sur le champ
“To= " etsélectionnez “SONG” a l'aide de la molette
JOG ou des touches INC/DEC. Appuyez ensuite une fois
sur la touche de curseur vers la droite de maniere a placer
le curseur sur le champ de sélection de la mémoire de
sonorités de morceaux.

SELECTIONNER UN NUMERO DE SONORITE - La
prochaine étape consiste a placer le curseur sur le champ
des numéros de sonorités et a déterminer I'emplacement
de sonorité (001 a 128) dans lequel vous chargerez la
sonorité a I'aide de la molette JOG, des touches INC/DEC
ou du pavé numérique.

REPERTOIRE DE FICHIERS - Pour visionner depuis le
répertoire de fichiers la liste des fichiers de sonorités
contenus sur la disquette insérée dans le W5/W7,
appuyez sur la touche [F8] (“Dir”).

CHARGER DES SONORITES DEPUIS UNE DIS-
QUETTE - Vous pouvez lancer l'opération de chargement
depuis 'écran Load from Disk/Voice en appuyant sur la
touche ENTER. Le W5/W7 vous donne la possibilité
d’annuler 'opération en affichant le message de confirmation
“Are You Sure?”. Appuyez sur la touche DEC pour annuler
lopération ou sur la touche INC pour charger le fichier
depuis la disquette. L’écran affichera le message
“Executing...”, vous indiquant que 'opération de chargement
est en cours. Lorsque le chargement est effectué, I'écran
affichera le message “Completed!”

REMARQUE: Il est possible de charger toutes les sonorités (“all
voices™), méme si la mémoire de morceaux sélectionnée comme
destination ne comprend pas de bangue de sonorités de morceaux.
Toutefois, avant de pouvoir charger une seule sonorité dans un
emplacement de mémoire de sonorités de morceaux, il vous faut d'ubord
créer une zone de mémoire de sonorités de morceaux en vous servant de
la fonction de mémoire de sonorités de morceaux (Song Voice Memory)
du mode Utilitaire. (Pour plus de détails, reportez-vous a la page 143.)
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La fonction Rename File (donner un nouveau nom a un fichier) vous permet de changer le nom
de tout type de fichier contenu dans une disquette.

e SO0NGei2LInit Sond 1

DISK

> Disk Status

> Save To Disk elete Fi1le
> Load From Disk > Format Disk

Status Save Load Rnam Del Format

POUR ACCEDER A LA FONCTION RENAME FILE
Pour accéder a la fonction Rename File (donner un nouveau nom
a un fichier) depuis I'écran de menu principal du mode Disque,
placez le curseur sur “Rename File” et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche [F5] (“Rename”).

= SONGS1ZLInit Sond 3
tRename File

Data 1 A
ng Qlce

nd+lUoice

g ATT TSong 15+U SFF Uoice

SELECTIONNER UN TYPE DE FICHIER - Placez le
curseur sur le type de fichier et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche de fonction [F2 a F6] correspondant au type de fichier
que vous souhaitez sélectionner.

Ee—— SONGoiZLINnit Sond 3
DISK:Rename File !
ESEQ-SMF From = FIL‘_‘E 1> TRV TFE, ML

Set&Press To = FILE CINMYLIFE]
[ENTER]

Name Dir

SELECTIONNER UN FICHIER - Sélectionnez le fichier
dont vous souhaitez changer le nom a l'aide de la molette
JOG, des touches INC/DEC ou du pavé numérique (dans le
champ “From = 7). Si vous le souhaitez, il vous est possible
de passer en revue les différents fichiers du répertoire de
fichiers en appuyant sur la touche [F8] (*Dir”).

NOM DE FICHIER - Appuyez sur la touche [F7]
(“Name”) pour activer Pécran de fichier Name et changer
le nom. Apres avoir choisi un nouveau nom de fichier,
appuyez sur la touche ENTER pour donner ce nouveau
nom au fichier.

FE’ B SONGeiZlINnit Sond 1
¥
L INMY ] ]

LIFE
123456789 | #$X&> (H—~_~ (3™
BCDEF GHMJKLMNOPRRSTUUWKYZ

LSPL]  # > I Hame[

Une fois la touche ENTER enfoncée, le W3/W7 vous
donne la possibilité d’annuler I'opération en affichant le
message de confirmation “Are You Sure?”. Appuyez sur la
touche DEC pour annuler I'opération ou sur la touche
INC pour donner un nouveau nom au fichier sur la
disquette. L'écran affichera le message “Executing...”,
vous indiquant que l'opération de changement de nom est
en cours. Lorsque le changement est effectué, 'écran
affichera le message “Completed!”.
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La fonction Delete File (effacer un fichier) vous permet d’effacer tout type de fichier de la
disquette insérée dans le W5/W7.

e SONGRi12LINnit Songy 2

DISK :

2> Disk Status > Rename File

? Save To Disk

> Load From Disk orma 1=
!

Status Save Load Fnam Del Format

POUR ACCEDER A 1A FONCTION DELETE FILE
Pour accéder a la fonction Delete File {effacer un fichier) depuis
I'écran de menu principal du mode Disque, placez le curseur sur
“Delete File” et appuyez sur la touche ENTER. Vous pouvez
également simplement appuyer sur la touche [F6] (“Delete”).

e SONGRIZLINnit Sond 1
DISK:Delete File
> All Data » ESEQ-SMF
> Uoice
ond+oice
g ATT 15on9 15U SAF Uoice

SELECTIONNER UN TYPE DE FICHIER - Placez le
curseur sur le type de fichier et appuyez sur la touche
ENTER. Vous pouvez également simplement appuyer sur la
touche de fonction [F2 a F6] correspondant au type de fichier
que vous souhaitez sélectionner.

Erm—— SONGoiZ2LInit Sond ]
DISK:Delete File

1 Sond From = FII;E Lt HERET

Set&Pregs To = Delete
[ENTER2]

ir

SELECTIONNER UN FICHIER - Sélectionnez le fichier
que vous souhaitez effacer a I'aide de la molette JOG, des
touches INC/DEC ou du pavé numeérique. Si vous le
souhaitez, il vous est possible de passer en revue les
différents fichiers du répertoire de fichiers en appuyant
sur la touche [F8] (“Dir”).

EFFACER UN FICHIER - Appuyez sur la touche
ENTER pour effacer le fichier.

Eoeen SONGoi1Z2LInit Sond ]
DISK:Delete File

1 Song From = FIl*.E B2:HERRT

Delete File
[— Are You sure? '\’es[INC]/NOEDEC]j

Vous pouvez lancer I'opération d’effacement depuis
l'écran Delete File ou depuis le répertoire de fichiers en
appuyant sur la touche ENTER. Le W5/W7 vous donne la
possibilité d’annuler 'opération en affichant le message de
confirmation “Are You Sure?”. Appuyez sur la touche
DEC pour annuler 'opération ou sur la touche INC pour
effacer le fichier sur la disquette. L'écran affichera le
message “Executing...”, vous indiquant que 'opération
d'effacement est en cours. Lorsque le fichier est effacé,
l'écran affichera le message “Completed!”.
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La fonction Format Disk (formatage de disquette) vous permet de formater une disquette double
densité (2DD) de 3,5 pouces selon la norme compatible avec le systeme opératoire du W5/W7 (9
secteurs et d’'une capacité de 720 kilo-octets).

oo SONGe@1LInit Sond 1

DISK

> Disk Statu > Rename File
> Save To Disk > Delete File
> Load From Disk > Formal Disk

Status Save Load Enam Del Format

POUR ACCEDER A LA FONCTION FORMAT DISK
Pour accéder 4 la fonction Format Disk (formater une disquette)
depuis I'écran de menu principal du mode Disque, placez le
curseur sur “Format Disk” et appuyez sur la touche ENTER. Vous
pouvez également simplement appuyer sur la touche {F7]
(“Format™).

INSERER UNE DISQUETTE - Le W5/W7 vous demandera
d'introduire une disquette vierge et d’appuyer sur la touche
ENTER

=—=n SONGE@1ILINnit Sond 1
DISKiFormat Disk ]

Please insert a blank disk
an
Press [Enterl

Status Save Load Rnam Del

FORMATER LA DISQUETTE - Le W5/W7 vous donne la
possibilité d'annuler l'opération en affichant le message de
confirmation “Are You Sure?”.

oo SONGE@iLInit Sond 1
DISK:Farmat Disk |

Please insert a blank disk

3
Format Disk
[ “fre wou"sure? Yes[INC1-No[DEC] |

Appuyez sur la touche DEC pour annuler 'opération ou sur la
touche INC pour formater la disquette. L'écran affichera le
message “Executing...”, vous indiquant que I'opération de
formatage est en cours. Lorsque la disquette est formatée,
I'écran affichera le message “Completed!”.

REMARQUE: Une fois la disquette formatée, toutes les données contenues
auparavant sur celle-ci seront effacées. Veillez a ne pas effacer de disquettes
contenant des données musicales importantes!
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POUR ACCEDER AU MODE UTILITAIRE

Pour accéder au mode Utilitaire, appuyez sur la touche UTILITY
de la section Mode du panneau. L’écran affiche le menu principal
des huit fonctions utilitaires. Les touches de curseur vous
permettent d’accéder aux diverses fonctions. 1l suffit de
positionner le curseur sur la fonction désirée et d'appuyer sur
ENTER, ou simplement d'utiliser les touches de fonction |F1 a
F8] correspondant au nom abrégé des fonctions utilitaires affiché
au bas de I'écran.

0 SONGeR1LInit Sond 1

UTILITY
7 Controllers
nitia Setup
7 Uoice Bulk Dume > Other Setuk
> Synth Setup > Greetind Messade
Mem Init Bulk Sunth CLrl r Msa

MEMORY - Permet de gérer les banques de mémoire de
sonorités de morceaux en copiant une banque entiere de
sonorités normales et rythmiques des banques de sonorités
internes, de morceaux (01 a 16), GM, présélectionnées et
externes (en option) dans la mémoire de sonorités de
morceaux du morceau en cours.

INITIALIZE - Permet de rappeler la banque de sonorités
normales et rythmiques internes par défaut de l'instrument.

VOICE BULK DUMP - Permet de transmettre l'intégralité de
la banque de sonorités normales et rythmiques internes
actuellement dans la mémoire du W5/W7 vers un autre W5/
W7 ou un appareil MIDI externe.

SYNTHESIZER SETUP - Permet de sélectionner I'accordage
général ainsi que les parametres de vélocité du clavier et des
commandes.

CONTROLLERS - Permet de régler l'affectation du curseur
linéaire (CS), de la commande de volume au pied ainsi que la
valeur d'initialisation de la commande au pied.

MIDI SETUP - Permet de déterminer le numéro d'appareil
du W5/W7, de régler le statut de son clavier ainsi que le statut
de changement de programme.

OTHER SETUP - Permet de régler le contraste de 'écran
LCD et de déterminer si un écran de confirmation s'affiche ou
non avant de commencer un travail d’édition.

GREETING MESSAGE - Permet de créer un message de
deux lignes, de 20 caracteres chacune. Celui-ci s'affiche des la
mise sous tension de I'appareil et pendant la mise en route du
systeme.

Le mode Utilitaire (Utility) vous permet de gérer les sonorités de morceaux, d’initialiser les
banques de sonorités internes, de déterminer les divers parametres MIDI et d’effectuer un transfert
global des données MIDI, de régler I'accordage général et les parametres de vélocité du clavier ainsi
que d’accéder a d’autres fonctions régissant le systeme général du W5/W7.

POUR VOUS DEPLACER DANS LE MODE UTILI-
TAIRE

Quelle que soit la fonction de mode Utilitaire dans laquelle vous
vous trouvez, il vous est toujours loisible de passer directement a
une autre fonction utilitaire en appuyant sur la touche de fonction
[F1 2 F8] qui correspond au nom de fonction abrégé affiché au
bas de l'écran.

POUR QUITTER LE MODE UTILITAIRE

Pour quitter le mode Utilitaire depuis I'écran du menu principal
du mode Utilitaire, appuyez une fois sur la touche EXIT. Pour
quitter le mode Utilitaire depuis une fonction de mode Utilitaire,
appuyez deux fois sur EXIT ou sur n'importe quelle touche
MODE du panneau.

REMARQUE: Le¢ séquenceur ne fonctionne pas quand le W5/W7 est dans le
mode Utilitaire.
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La fonction Song Voice Memory (mémoire de sonorités de morceaux) vous permet de gérer les
banques de mémoire de sonorités de morceaux en copiant l'intégralité d’'une banque de sonorités
normales et rythmiques depuis les banques de sonorités internes, de morceaux (01 a 16), GM et
preé-sélectionnées dans la banque de mémoire de sonorités de morceaux du morceau en cours.
(REMARQUIE: si vous installez une carte d’extension de mémoire d’ondes/de sonorités (en option),
vous pouvez également effectuer une copie a partir d’'une banque de sonorités pré-sélectionnées
externes.)

Chaque multi de morceau interne (01 a 16) peut recevoir une banque de mémoire de sonorités
de morceaux qui pourra contenir 128 sonorités normales et 2 sonorités rythmiques. Ces sonorités
de morceaux sont propres a chaque multi de morceau et sont accessibles a partir du multi courant.
(Les sonorités de morceaux d’autres multis ne sont pas accessibles a partir du multi courant.)

Si vous tentez de sélectionner une sonorité de morceau alors que la banque de sonorités de
morceaux du multi courant est vide, dix astérisques s’affichent au lieu du nom de morceau
sélectionné et aucun son n’est produit quand on joue sur le clavier du W5/W7 ou si les messages de
notes MIDI entrant sont recus par la piste spécifiée.

= SONGE@iL[Init Sond 3
Chil oSO8 1 [orsorksokskok ]
INE|o|o|lo|ojo|o|la|le|e|p|a|a|a|la|a|a
FaN|Q|0|(0(0|¢|0|0(0(0|0|0/0(0(0|0|0
Ml h dh dh AR R AR SR AR AR AR AR R AR IR AR 4]
BT Or Gt St 5t Br Rd Ld Dr Fd Fx Et Fc S S
M1t/ Sed SeluF [¥-Bank-a] Dir

e POUR ACCEDER A LA FONCTION SONG VOICE
MEMORY

REMARQUE: Une facon intelligente de gérer
les sonorités de morceaux consiste a
commencer par arranger les sonorités
désirées dans la banque de sonorités internes
en recourant a la fonction de sauvegarde de
sonorités (Store Voice) — reportez-vous a la
section “Mode de Sauvegarde” a la page 130.
Copiez ensuite la banque de sonorités internes
dans la banque de sonorités de morceaux
sélectionnée a l'aide de la fonction Song Voice
Memory (mémoire de sonorités de morceaux)
du mode Utilitaire.

COPIER DANS LA MEMOIRE DE SONORITES DE

Pour accéder a la fonction Song Voice Memory (mémoire de
sonorités de morceaux) depuis I'écran de menu principal du
mode Utilitaire, placez le curseur sur MEMORY et appuyez sur la
touche ENTER ou appuyez simplement sur la touche [F1]
(“Mem”). L'écran Copy Voice s'affichera alors.

e SONGe@iLINn:it Sond 1
UTILITY:MEMORY

Coky Uoice From
To SONG @1lInit Song 1
Ihit Bulk SYnth Cirl

SELECTIONNER UNE BANQUE DE SONORITES - Le
champ “From = ” (“de”) est mis en évidence pour indiquer
que vous pouvez déterminer la banque que vous désirez
copier dans la mémoire de sonorités de morceaux sélection-
née.

Sélectionnez la banque de sonorités — internes, de morceaux
(01 4 16), GM, pré-sélectionnées — que vous désirez copier a
l'aide de la molette JOG ou des touches INC/DEC.

REMARQUE: Vous ne pouvez déplacer le curseur sur le champ “To= "
(“a”) et sélectionner une mémoire de sonorités de morceaux a partir du mode
Utilitaire. Le numéro de morceau courant s’affiche et celui-ci est accessible a
partir du mode de Morceaux. Pour sélectionner une autre mémoire de
sonorités de morceaux dans laquelle copier la banque de sonorités, retournez
au mode de Morceaux, appuyes sur la touche [F2] (“Seq”) et sélectionnez un

autre morceau. (Pour plus d'informations au sujet de la sélection de

morcedux, reportez-vous au mode de Morceaux ala page 80.)

MORCEAUX - Apres avoir désigné la banque de sonorités a
partir de laquelle vous désirez effectuer une copie, appuyez
sur ENTER. Le W5/W7 vous donne la possibilité d’annuler
Popération en affichant le message de confirmation “Are You
Sure?”. Appuyez sur DEC pour annuler I'opération ou sur
INC pour copier la banque de sonorités. Le message
“Executing...” s'affiche, vous indiquant que 'opération de
copie est en cours. Une fois 'opération terminée, le message
“Completed!” s'affiche.

REMARQUE: Si la banque de sonorités de morceaux du multi
actuellement sélectionné est vide, il convient de sélectionner un espace de
mémoire avant que lopération de copie puisse démarrer. Si la banque de
sonorités de morceaux de multi courante contient déja des sonorités, il
convient d’effacer les sonorités de morceaux existantes avant que
Popération de copie puisse démarrer

REMARQUE: Tout comme pour les données de séquences de morceaux
de multi, les données de sonorités de la mémoire de banque de sonorités
de morceaux ne sont pas conservées a la mise hors tension de lappareil;
il faut donc toujours veiller a sauvegarder sur disquette les données de
sonorités de morceaux que vous désirez conserver avant de mettre
Vappareil hors tension.
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La fonction Initialize (initialisation) permet de remettre toutes les sonorités normales internes a
leur valeur d’origine. L’élément AWM interne et d’autres paramétres de sonorités normales sont
effacés et chaque sonorité devient “a un élément sans onde”, c.-a.-d. le statut que vous désirez lui
attribuer pour créer une sonorité depuis le départ. Les deux mémoires de sonorités rythmiques
internes se verront attribuer les numéros de sonorités rythmiques GM #01 et #02.

e POUR ACCEDER A 1A FONCTION INITIALIZE
Pour accéder a la fonction Initialize (initialisation) depuis l'écran
de menu principal du mode Utilitaire, placez le curseur sur
INITIALIZE et appuyez sur la touche ENTER ou appuyez
simplement sur la touche [F2] (“Init”). L'écran Initialize saffichera
alors.

G SONGe@ICInhit Sond 3]
UTILITY:Initialize

Internal Voice Bank
Press [ENTERI]

em | Jhit] Bulk Suynth CTtrl

La fonction Voice Bulk Dump (transfert global des sonorités) vous permet de transmettre la
banque enti¢re des 128 sonorités normales et des 2 sonorités rythmiques internes conservées dans

le W5/W7 vers un autre W5/W7 ou un appareil MIDI externe.

e POUR ACCEDER A LA FONCTION VOICE BULK
DUMP
Pour accéder a la fonction Voice Bulk Dump (transfert global des
sonorités) a partir de I'écran de menu principal du mode Utili-
taire, placez le curseur sur VOICE BULK DUMP et appuyez sur la
touche ENTER ou appuyez simplement sur la touche [F3]
(“Bulk”). L’écran Voice Bulk Dump saffichera alors.

e SONGeRilInit Sondy 31
UTILITY:Uoice Bulk Dump |

From Internal Bank all Uoice

Pres=s [ENTER]

=

TRANSFERER LA BANQUE DE SONORITES INTER-
NES - Pour transférer la banque de sonorités internes, il suffit
d'appuyer sur ENTER. Le W5/W?7 vous donne la possibilité
d'annuler P'opération en affichant le message de confirmation
“Are You Sure?”. Appuyez sur DEC pour annuler l'opération
ou sur INC pour lancer I'opération de transfert de la banque

INITIALISER LES BANQUES DE SONORITES INTER-
NES - Pour initialiser les banques de sonorités internes,
appuyez sur ENTER. Le W5/W7 vous donne la possibilité
d’annuler l'opération en affichant le message de confirmation
“Are You Sure?”. Appuyez sur DEC pour annuler Popération
ou sur INC pour initialiser la banque de sonorités. Le message
“Executing...” s'affiche, indiquant que linitialisation est en
cours. Une fois 'opération terminée, le message “Completed!”

saffiche.

REMARQUE: Avant de lancer
lopération, il faut veiller a relier la sortie
MIDI OUT du W5/W7 a l'entrée MIDI IN
de lappareil externe a I'aide d’un cable
MIDIL. 1l faut veiller également a attribuer
le méme numéro d’appareil pour les deux
instruments. (Vous trouverez plus
d’informations au sujet de attribution de
numéro d’appareil du W5/W7 a la page
148)

de sonorités. Les sonorités sont décomptées au fur et a mesure
de leur transfert. Une fois l'opération terminée, le message
“Completed!” saffiche.

¢ RECEVOIR DES DONNEES GLOBALES DE SONO-

RITES

Pour recevoir des données globales de sonorités a partir d'un
appareil externe, il est nécessaire d'interrompre au preéalable toute
opération d’enregistrement, d’édition de morceau ou d'édition de
sonorité. Il faut veiller également  attribuer le méme numéro
d’appareil aux deux instruments. Vous pouvez alors lancer
l'opération de transfert global de sonorités depuis I'appareil
exterre.
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La fonction Synthesizer Setup (configuration du synthétiseur) permet de régler I'accordage
général, les parametres de vélocité du clavier ainsi que les paramétres des commandes.

POUR ACCEDER A LA FONCTION SYNTHESIZER
SETUP

Pour accéder a la fonction de configuration du synthétiseur
depuis l'écran de menu principal du mode Utilitaire, placez le

curseur

sur INITIALIZE et appuyez sur la touche ENTER ou

appuyez simplement sur la touche [F4] (“Synth”). L’écran

Synthes

izer Setup s'affichera alors.

uT

Master Tune = I’%
Uelocity =0 Curve= B:normal
Controller = hold

== SONGE@i[Irnit Sony 3J
ILITY:SYnthesizer Setup

MASTER TUNE (-63 a + 63) - Permet de régler I'accordage
fin général du W5/W7 par incréments de 1,17 centiemes. Les
pararetres d’'accordage général n'affectent que le générateur
de sons interne du W5/W7 et restent sans effet sur les
numeéros de notes transmises via MIDI OUT. (REMARQUE:
Vous pouvez régler l'accordage de sonorités spécifiques dans
le mode d’Edition de Sonorités. Pour plus d'informations,
reportez-vous a la page 118.)

VELOCITY (off, 1 ~ 127) - Permet de régler la réponse de la

sen:
Les

sibilité a la vélocité du clavier du W5/W7. (REMARQUE:
parametres de vélocité affectent le clavier du W5/W7 mais

wont aucun effet sur les données du séquenceur interne ou
les données MIDI recues par le W5/W7.)

Sortie

1 ~ 127 - Quand le parametre Velocity est réglé sur une
valeur de vélocité spécifiée, toutes les notes sont “fixées” a
la méme valeur de vélocité, quelle que soit la véritable
vélocité de jeu.

Veélocité fixe=1a 127

Valeur fixe

Sortie

Vélacité des touches

Lors de la reproduction de sons d'un instrument qui reste
insensible a la vélocité des touches (comme l'orgue ou le
clavecin), il est préférable de choisir une valeur de vélocité
fixe. 1l est toutefois préférable de régler tous les
parametres de sensibilité a la vélocité de la sonorité sur 0
(dans le mode d’Edition de Sonorités) dans la mesure ou
toutes les autres sonorités conserveront ainsi leur vélocité
normale.

OFF - Si le parametre Velocity est désactivé, le générateur
de sons du W5/W7 se basera sur les parametres de la
courbe de vélocité (Velocity Curve) déterminée pour
répondre a la vélocité de jeu.

Vélocité fixe=désactivée

Vélocité des touches

VELOCITY CURVE (0: normal, 1: soft-1, 2: soft-2, 3:
easy, 4: wide, 5: hard, 6: cross-1, 7: cross-2) - Les
parametres de la courbe de vélocité sélectionnée déterminent
la facon dont le générateur de sons réagit a la vélocité de jeu
quand le parametre Velocity est réglé sur “off” (voir Velocity,
ci-dessus).

Les parametres de la courbe de vélocité affectent uniquement
les notes jouées sur le clavier du W5/W7 et peuvent
également étre transmis via MIDI OUT. La courbe n'a aucun
effet sur les messages de note en provenance d’'un appareil
externe et recues via MIDI IN.

Sortie

Sortie

Sortie

NORMAL - Une courbe de vélocité normale signifie que
la vélocité du clavier du W5/W7 répond a la vitesse de
votre jeu a son niveau de vélocité de base, ainsi que
déterminé par les parametres de la vélocité de touche de
la sonorité. (Pour plus d'informations, reportez-vous a
“mode d"Edition de Sonorité”, fonction Amp, page 113))

0. Normal

Vélocité des touches

SOFT-1 ET SOFT-2 - Les courbes de vélocité 1 (soft-1)
et 2 (soft-2) vous permettent d’accroitre la sortie du son a
des degrés plus et moins élevés pour les vélocités de
touche plus lentes.

2. Sof1-2

1. Soft-1

Sortie

Vélocité des touches Vélocité des touches

EASY - La courbe de vélocité 3 (easy) permet une sortie
légerement accrue pour les vélocités de touche plus
rapides et plus lentes tout en produisant une courbe de
vélocité normale pour les valeurs de vélocité de touche se
trouvant entre ces extrémes.

3. Easy

...correspond a la
courbe de vélocité normale

Vélocité des touches
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WIDE - La courbe de vélocité 4 (wide) permet de réduire
légerement la sortie pour les vélocités de touche plus
lentes et d’accroitre la sortie pour les vélocités de touche
plus rapides.

4. Wide

Sortie
...correspond a la

courbe de vélocité normale

Vélocité des touches

HARD - La courbe de vélocité 5 (hard) requiert une
frappe de touche extrémement dure pour produire un
son de niveau plus élevé.

5. Hard

Sortie .
...correspond a la

courbe de vélocité normale

Vélocité des touches

CROSS-1 ET CROSS-2 - Les courbes de vélocité 6
(cross-1) et 7 (cross-2) permettent de transposer entre
deux sonorités a I'aide de la vélocité de touche. A cet effet,
attribuez a une sonorité une sensibilité a la vélocité de
touche de valeur positive et a Fautre sonorité une
sensibilité a la vélocité de touche de valeur négative. (Pour
en savoir plus au sujet de la sensibilité a la vélocité du
clavier, reportez-vous a “Mode d”Edition de Sonorités”,
fonction AMP, a la page 113.) Ceci s'applique aux
SONOTités superposées, aux sonorités a 4 zones et aux
sonorités normales possédant 2 éléments AWM ou plus.

6. Cross-1 7. Cross-2

Sortie Sortie

Vélocité des touches Vélocité des touches

...correspond a la
courbe de vélocité normale

CONTROLLER (hold, reset) - Permet de déterminer la
réponse du W5/W7 aux diverses données des commandes.

HOLD - Ce réglage empéche le retour aux valeurs par
deéfaut de la modulation ainsi que d’autres parametres
réglés a partir du commutateur au pied et d’autres
controleurs et des données MIDI importées. (REMAR-
QUE: 1l convient de régler le parametre Controller sur
“hold” avant de recevoir des données GM.)

RESET - Permet de rendre leur valeur par défaut aux
commandes: commande au pied = Init Value (voir
“Controllers”, ci-dessous); commande de volume au pied
= Max; panoramique = Center; expression = Max; hauteur
du son = Center; autres = 0.
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type linéaire ou du type activé/désactivé.

La fonction Controllers (commandes) permet de régler I'assignation de la commande linéaire
(CS), de Ia commande de volume au pied ainsi que la valeur initiale du contrdleur au pied.

Les diverses commandes du W5/W7, telles quelles sont définies par les spécifications MIDI,
peuvent envoyer des messages MIDI de modification de commande, y compris des commandes du

TYPE LINEAIRE TYPE ACTIVE/DESACTIVE
001 | Modulation wheel 064 | Sustain
002 | Breath controller 065 | Portamento
004 | Foot controller 066 | Sostenuto
005 | Portamento time 067 | Soft pedal
006 | Dataentry 069 | Hold 2
007 | Main volume 084 | Portamento control (legato)
008 | Balance control 091 | Exeffect depth (reverb)
010 | Panpot 092 | Tremolo depth (effect 2}
011 | Expression 093 | Chorus depth
094 | Celeste depth (effect 4)
095 | Phaser depth (delay)
e POUR ACCEDER A LA FONCTION

CONTROLLERS

Pour accéder 2 la fonction Controllers (commandes) a partir de
l’écran de menu principal du mode Utilitaire, placez le curseur sur
CONTROLLERS et appuyez sur la touche ENTER ou appuyez
simplement sur la touche [F5] (“Curl”). L'écran Controllers
s'affichera alors.

e SONGe@1ILInit Sond 1
UTILITY:Controllers
CS Assign

FootUgl Assidn
FC Init Ualue

em Init Bulk SYnth

CS ASSIGN (off, 001 a 031, 033 a 119) - Permet d’assi-
gner la fonction de la commande linéaire CS. Cette com-
mande permet de régler les parametres du W5/W7 et des
données MIDI, ainsi que de transmettre les messages de
modification de commande aux appareils MIDI externes, dans
la mesure ot la commande CS transmet les données en
fonction du numéro de commande MIDI que vous lui aurez
attribué. Si vous désirez utiliser la commande CS pour
commander les sonorités du W5/W7, veillez a ce que le
numéro de commande MIDI que vous attribuez a celle-ci soit
identique au numéro de commande MIDI sélectionné pour le
parametre que vous désirez controler. (Les numeéros de
modification de commande 000 et 032 sont destinés aux
messages de sélection de banque et ne peuvent des lors étre
attribués a d'autres commandes.)

FOOT VOLUME ASSIGN (007: main volume, 011:
expression) - Permet d'attribuer le numéro de modification
de commande MIDI a la commande de volume au pied.

MAIN VOLUME - Quand elle est réglée sur 007 (volume
principal), la commande au pied du W5/W7 permet de
commander le volume principal. Les messages MIDI
seront envoyés en fonction de la position de commande
de volume au pied. Quand Teffet d'insertion (Insertion
Effect) est activé, le volume principal se regle apres l'effet
d'insertion et I'assignation de basse limite d’expression
(Expression Low Limit) se sera pas prise en comple.

EXPRESSION - Quand elle est réglée sur 011 (expres-
sion), la commande au pied permet de régler l'expression.
Les messages MIDI sont transmis en fonction de la
position de la commande de volume au pied,
conformément a l'assignation de basse limite d’expression
(Expression Low Limit). Reportez-vous a Mode d’Edition
de Sonorités, fonction Controller, page 122).

FC INIT VALUE (0 a 127) - Permet de déterminer la valeur
initiale de la commande au pied quand celle-ci n’est pas raccor-
dée. Cette valeur n'a toutefois aucun effet quand vous utilisez
cette commande en temps réel. Quand les messages de la
commande au pied MIDI sont recus, la valeur réglée sera la valeur
maximale que le W5/W7 recevra. (La valeur reglée détermine
également la valeur par défaut de la commande de configuration
de synthétiseur; voir page 145, ci-avant.)

—
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| CONFIGURATION MIDI “MIDI SE

La fonction MIDI Setup (configuration MIDI) permet de déterminer le numéro dappareil du
W5/W7, de régler le statut de son clavier ainsi que celui des modifications de programmes.

e POUR ACCEDER A LA FONCTION MIDI SETUP
Pour accéder a la fonction MIDI Setup (configuration MIDI) a
partir de I'écran de menu principal du mode Utilitaire, placez le
curseur sur MIDI SETUP et appuyez sur la touche ENTER ou
appuyez simplement sur la touche [F6] (“MIDI1). L'écran MIDI
Setup s‘affichera alors.

SONGE@1CLInit Sond 1

| erererererers |
UTILITY:MIDI SetupP
Bam
Loca on
Prodram Chande i9nore bank select
em Init Bulk Sunth TUrTIMIDI[Tthr F=a

Deui?e Number

DEVICE NUMBER (off, 1 a 16, all) - Permet de déterminer
le canal (1 a 16) sur lequel le W5/W7 recoit ou transmet les
messages exclusifs au systeme MIDI, tels que les changements
de parametres et les données globales. (REMARQUE: 11
convient d'assigner le méme numéro a chacun des instru-
ments coNNectés pour Pouvolr recevoir et transmettre des
données entre des appareils externes et le W5/W7.)

OFF - Quand le parametre est réglé sur “off”, les messages
exclusifs du systeme ne seront ni transmis ni regus.

ALL - Quand le parametre est réglé sur “all”, les messages
exclusifs du systeme seront transmis sur le canal 1 et
recus sur n'importe quel canal.

LOCAL (off, on) - For determining whether or not the
keyboard will play the W5/W7’s tone generator. If you are
using the W3/W7 by itself, you should usually leave Local set
to “on’”.

LOCAL (off, on) - Ce parametre permet de déterminer si le
clavier jouera le générateur de sons du W5/W7. Si vous ne
vous servez que du W5/W7, il est préférable de régler ce
parametre sur “on”.

ON - Quand il est réglé sur “on”, le clavier du W5/W7
jouera le générateur de sons interne.

OFF - Quand il est réglé sur “off”, le générateur de sons
du W5/W7 produira le son uniquement en fonction des
messages recus via MIDI IN; les messages seront toutefois
transmis par MIDI OUT quand vous jouez sur le clavier
ou quand vous utilisez les diverses commandes. Les
données du séquenceur de morceaux du W5/W7 seront
toujours transmises au générateur de sons interne, quel
que soit le réglage du parametre Local.

Si vous désirez commander d'autres générateurs de sons
MIDI connectés au W5/W7 a partir du clavier de ce
dernier, il convient de sélectionner “off” au parametre
Local, de sorte a pouvoir jouer sur d’autres générateurs de
sons en sélectionnant une des pistes (1 a 16) du muld
correspondant au canal MIDI du générateur de sons

externe sur lequel vous désirez jouer. Bien quil ne soit
pas possible de jouer sur le générateur de sons du W5/
W7 a partir du multi en mode de Morceaux, le clavier
transmet toujours les données MIDI au séquenceur
interne de morceaux . Lors d'un enregistrement, les
données MIDI sont retransmises du séquenceur interne
au générateur de sons interne, de sorte que vous puissiez
entendre ce que vous jouez pendant Penregistrement.

Le réglage sur “off” peut également étre utile dans d'autres
situations. Certains processeurs MIDI disponibles sur le
marché sont capables de recevoir une cérie de données de
commandes et de notes MIDI et de créer sur base de
celles-ci des harmonies ou d'autres effets musicaux. Si
vous disposez de ce type de processeur MIDI, il peut
savérer utile de régler ce parametre sur “off” et d'effectuer
les connexions MIDI de sorte que les données de
commandes et de notes sortant par la borne MIDI OUT
du W5/W7 soient traitées par le processeur MIDI et
ensuite retransmises auW5/W7 via MIDI IN.

Si vous utilisez un séquenceur externe conjointement au
W5/W7, vous transmettrez probablement les données via
la borne MIDI OUT du W5/W7 afin d'effectuer l'enregis-
trement sur le séquenceur. Pour la reproduction, les
données seront ensuite retransmises de la borne MIDI
OUT du séquenceur a la borne MIDI IN du W5/W7. Si le
séquenceur externe est capable de retransmettre les
données en cours d'enregistrement, sélectionnez “off” de
sorte que le W5/W7 ne produise de son qu'en fonction
des données en provenance du séquenceur externe.

PROGRAM CHANGE (off, on, ignore bank sclect) - Ce
parametre permet de déterminer la facon dont le W5/W7
répond a un message de modification de programme requ via
MIDI IN ainsi que la facon dont les messages de modification
de programme sont transmis via MIDI OUT. Le réglage
habituel de ce parametre est sur “on”.

ON - Quand le parametre est réglé sur “on”, les messages
de sélection de banque et de modification de programmes
recus seront exécutés. (REMARQUE: Réglez le parametre
Program Change sur “on” quand vous chargez les
données a partir de disquette.)

OFF - Quand le parametre est réglé sur “off”, les messages
de sélection de banque et de modification de programmes
Tecus seront ignorés et les messages de modification de
programme ne seront pas transmis.

IGNORE BANK SELECT - Quand le parametre est réglé
sur “ignore bank select”, seuls les messages de sélection de
banque seront ignorés.
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AUTRES CONFIGURATIO|

La fonction Other Setup (autres configurations) vous permet de régler le contraste de I'écran
LCD et de déterminer si I'écran de confirmation s’affiche avant le lancement d’une opération

d’édition.

e POUR ACCEDER A LA FONCTION OTHER SETUP
Pour accéder a la fonction Other Setup (autres configurations) a
partir de I'écran de menu principal du mode Utilitaire, placez le
curseur sur OTHER SETUP et appuyez sur la touche ENTER ou
appuyez simplement sur la touche {F7] (“Other”). L'’écran Other
Setup s'affichera alors.

o SO0NGeE@ilInit Sond 1]
UTILITY:Other Setur

LCD contrast 5
Edit Confirm
em Init Bulk S4Ynth Ctrl =9

LCD CONTRAST (0 a 31) - Permet de régler le contraste de
I'écran LCD. Pour augmenter le contraste, sélectionnez des
valeurs plus petites. Pour le réduire, sélectionnez des valeurs
plus grandes.

EDIT CONFIRM (off, on) - Quand le parametre de
confirmation d’édition est activé, le W5/W7 vous donne la
possibilité d’annuler l'opération en affichant le message de
confirmation “Are You Sure? Yes[INC)/No[DEC]”. Quand ce
parametre est désactivé, le message de confirmation ne
saffiche pas, c.-a.d. que 'opération d’édition démarre des que
vous appuyez sur la touche ENTER.

'GREETING MESSAGE”

La fonction Greeting Message (message de bienvenue) permet de créer un message de deux
lignes, de 20 caracteres chacune. Celui-ci s’affiche des la mise sous tension de I'appareil et pendant

la mise en route du systéeme.

¢ POUR ACCEDER A I A FONCTION GREETING
MESSAGE
Pour accéder a la fonction Greeting Message (message de
bienvenue) depuis 'écran de menu principal du mode Utilitaire,
placez le curseur sur GREETING MESSAGE et appuyez sur la
touche ENTER ou appuyez simplement sur la touche [F8]
(*Msg"). L'écran Greeting Message s'affichera alors.

e SONGeR1ilInit Sond 1

come To "W’
am _ready !!
#$548° ()-a L3N Mokt ,

9 BN _
JKLNNDPQRSTUW"!"Z? i( =>

CREER UN MESSAGE DE BIENVENUE - Pour créer un
message de bienvenue, sélectionnez la ligne de message
supérieure ou inférieure a 'aide des touches [F6] et [F7].
Placez le curseur a Faide des touches [F4] et {F5] et sélection-
nez les caracteres a l'aide des touches de curseur, INC/DEC
ou de la molette JOG. La touche [F3] (“[SPC]”) vous permet
d’entrer un espace. Une fois le message créé, appuyez sur la
touche de sortie EXIT ou sur toute autre touche MODE du
panneau pour retourner au menu principal du mode
Utilitaire.
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Le W5/W7 pourrait afficher certains des messages d’erreur suivants lorsque vous tentez d’effectuer certaines opérations.

Chacun de ces messages d’erreur est décrit ci-dessous.
MEMOIRE

MESSAGES AFFICHES

EXPLICATIONS

Song memory full !

La mémoire interne du séquenceur est remplie. Vous ne pouvez exécuter d’opérations de morceaux
nécessitant enregistrement, réception de données globales et chargement depuis des disquettes.

Data Empty !

Vous avez tenté d’effectuer une opération de morceau dans une mesure ne contenant aucune données,

Song voice memory full !

Vu que la mémoire interne est remplie, il vous est impossible de créer une banque de mémoire de sonorités
de morceaux.

Song element memory full !

Vu que la mémoire interne est remplie, les éléments ne peuvent étre chargés.

Song voice does not exist !

Vu quaucune banque de sonorités de morceaux n'a été créée pour le morceau sélectionné, les sonorités ne
peuvent sélectionnées ou éditées depuis la banque de sonorités de morceaux.

Voice bank is off !

Vu que la banque de sonorités est positionnée sur “off” (L'écran Voice Category m'affiche aucune donnée),
vous n'avez pas acces au mode d’Edition de Sonorités.

No data! Vous avez tenté de rappeler une sonorité de morceaux dans une banque de sonorités de morceaux “source”
non-existante.
DISQUE '
MESSAGES AFFICHES EXPLICATIONS
Disk not ready ! La disquette n'est pas insérée correctement dans le lecteur de disquette.
Bad disk ! La disquette insérée est défectueuse.

Write protected !

Vous avez tenté de sauvegarder des données sur une disquette dont I'onglet de protection a été mis en place
pour protéger les données.

Media type error !

La disquette que vous utilisez n'est pas du type 2DD (a double densité).

1legal file !

Le type de fichier sélectionné ne peut étre lu par le WS/W7.

File not found !

Le W5/W7 na pu trouver le fichier souhaité sur la disquette insérée.

Disk full !

La mémoire de la disquette est remplie.

Hlegal disk !

Le W5/W7 ne peut lire les données de la disquette introduite.

Disk unformatted !

La disquette n'a pas été formatée.

File already exists !

La disquette comprend déja un fichier répondant au méme nom.

Nlegal file name !

Le W5/W7 ne peut identifier le nom de fichier.

MIDI
MESSAGES AFFICHES EXPLICATIONS
MIDI buffer full ! Vous avez tenté de recevoir ou de transmettre une vaste quantité de données MIDI excédant les capacités

de traitement du W5/W7.

MIDI data error !

Une erreur a été commise lors du transfert ou de la réception de données MIDL.

MIDI checksum error !

Une erreur a été commise lors de la réception de données globales.

Device number is off !

Vu que le numéro de l'appareil est absent, les données globales ne peuvent étre transmises ou reques.

Device number mismatch !

Vu que les numéros des appareils ne correspondent pas, les données globales n'ont pu étre regues ou
transmises.

AUTRES

MESSAGES AFFICHES

EXPLICATIONS

Change internal battery !

La batterie de sauvegarde interne doit étre remplacée.

lllegal data !

Les données entrées sont illogiques pour le W5/W7.

Data is corrupted. Fixed !

Vu que les données ont été corrompues, la mémoire interne a été remplacée par le statut déterminé a I'usine.

SME illegal timebase !

Les données de tempo issues d’un autre appareil SMF (MIDI standard) ne sont pas compatibles avec la
piste de tempo du W5/W7.
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11 se peut que le W3/W7 ne réagisse pas toujours de la maniere attendue. Cela ne
signifie toutefois pas nécessairement qu'il y a probléme; peut-étre avez-vous omis une
étape importante ou appuyé sur la manvaise touche pour effectuer l'opération souhaitée
tant vous étiez absorbé dans la composition.

Souvent, la plupart des erreurs d'utilisation sont mineures {oublier de régler le volume
de l'instrument ou du systéme de contrdle; des erreurs si élémentaires que l'utilisateur n’y
pense pas la plupart du temps!). Un ensemble de parametres mal défini, un cable défec-
tueux ou des cdbles mal connectés constituent également des sources fréquentes de
problemes.

ISOLER LE PROBLEME

Si un probleme apparent survient, la premiere chose a faire est d’isoler la cause de ce probleme et de déterminer s'il est interne (ex.:
causé par les réglages de parametres) ou externe (ex.: causé par de mauvaises connexions, lamplificateur, etc.).

1. ECOUTE VIA UN CASQUE

Branchez un casque d’écoute 2 la prise PHONES du W5/W7, montez le curseur de
volume et jouez. Si le son passe bien dans le casque d’écoute, cela veut dire que le
probleme est externe. Cela signifie donc que les connexions ont été mal effectuées,
qu'un cable est défectueux, ou que le probleme provient des parametres de 'amplifica-
teur ou du mélangeur.

2. SELECTIONNER UNE AUTRE PISTE OU CHANGER DE MODE

Si le probleme se répete lors de 'écoute au casque, sélectionnez alors une autre piste et
jouez. Si vous vous trouvez en mode de Jeu de Sonorités “Voice Play”, passez au mode
de Jeu de Morceaux “Song Play” et sélectionnez une autre piste. Si le probleme a
disparu, alors il est probable qu'un réglage de parametre dans la sonorité d’instrument
de la piste fautive est a 'origine du probléeme. Si le probleme réapparait dans toutes les
pistes ou tous les modes, la cause pourrait résider dans un parametre du mode Utili-
taire ou dans un autre parametre affectant tous les modes.

3
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PROBLEMES COURANTS ET CAUSES EVENTUELLES

PROBLEMES D’AMPLIFICATEUR, DE MELANGEUR, DE CONNEXIONS

SYMPTOME

CAUSE EVENTUELLE

Aucun son

* Lamplificateur/le mélangeur est-il sous tension? ,

* Le volume de l'amplificateur/du mélangeur est-il assez élevé?

* Les sorties du W5/W7 sont-elles bien raccordées aux entrées de Famplificateur/du mélangeur?

* Les cables de raccordement sont-ils dénudés ou court-circuités? Présentent-ils tout autre défaut?
Essayez de remédier au probleme en remplacant les cables.

Son distordu

* Le W5/W7 est-il raccordé a une entrée pour microphone ou d'instrument de haute sensibilité de
votre amplificateur ou mélangeur? Diminuez le niveau de sortie du W5/W7 pour éviter de saturer
les entrées de l'amplificateur/du mélangeur.

PROBLEMES REIATIFS AUX REGLAGES DE PARAMETRES DU W5/W7

SYMPTOME

CAUSE EVENTUELLE

Aucun son

* Les réglages de panoramique du mélangeur et de la sonorité (en mode d’Edition de Sonorités
“Voice Edit”) affectent-ils le méme coté de 'image stéréo? (Voir page 112)

* Le volume de la piste sélectionnée est-il assez élevé? (Voir page 77.)

* Les parametres de niveau de l'amplificateur disposent-ils de valeurs assez élevées? (Voir page
113)

* Avez-vous attribué des valeurs appropriées aux parametres de notes de sonorités et de vélocité?
(Voir page 112, 113))

* Si une commande de volume au pied est raccordée au W5/W7 ou si un contréleur est assigné a la
commande de volume, le contrdleur a-t-il été réglé de maniere & produire un niveau de volume
suffisant? (Voir page 147.)

* Lalimite de la note la plus haute ou la plus basse est-elle correctement définie? (Voir page 112.)
* Le générateur d'enveloppe de hauteur est-il correctement réglé? Il se peut que la hauteur définie
se trouve en deca du spectre audible. (Voir page 117.)

* Le réglage du filtre ne coupe-t-il pas la majeure partie des fréquences? (Voir page 116.)

* Le niveau général des sonorités est-il assez éleve? (Voir page 110.)

* Le temps d'attaque du générateur d’enveloppe d’amplitude correspond-t-il 4 une valeur
excessivement longue? (Voir page 114.)

* L’élement d’'onde approprié est-il assigné a la sonorité? (Voir page 112.)

* Les paramétres de la courbe de vélocité sont-ils appropriés? (Voir page 145.)

* Les niveaux de volume des instruments du multi sont-ils assez élevés? (Voir page 77.)

* Les canaux de transmission des pistes du séquenceur correspondent-ils bien aux canaux des
instruments de multis? (Voir page 82.)

* L'accordage est-il correct? (Voir page 78.)

* Le parameétre de hauteur de note est-il correctement défini? (Voir page 78.)

* Le parametre de clavier local est-il positionné sur la valeur “off™? (Voir page 148.)

* Si le multi utilisait les sonorités de morceaux avant la mise hors tension, le clavier ne produira
aucun son lorsque I'appareil sera remis sous tension. En effet, les données de sonorités de mor-
ceaux auront été perdues. Changez de banque de sonorités ou chargez a nouveau les données de
sonorités de morceaux.

Hauteur incorrecte

* Les parametres de hauteur de note sont-ils correctement définis pour chaque sonorité? (Voir page
118)

* Les paramgtres de hauteur de note sont-ils correctement définis pour chaque instrument du
multi? (Voir page 78.)

* Les paramétres d’accordage sont-ils correctement définis pour chaque instrument du multi? (Voir
page 78.)

* Le parametre d’accordage général est-il correctement défini? (Voir page 78.)

Hauteur instable et mal définie

* Le parametre de hauteur aléatoire est-il correctement défini? (Voir page 118.)

* Le parametre de polarisation du générateur d’enveloppe de pression apres enfoncement est-il
correctement défini? (Voir page 122.)

* Le parametre de modulation de hauteur de I'OBF correspond-t-il 4 une valeur excessivement
élevée? (Voir page 121.)

* Le géneérateur d'enveloppe de hauteur est-il correctement défini? (Voir page 118.)

Certaines notes ne sont pas jouées

* Les données de séquences dépassent-elles la capacité de polyphonie maximale (32 notes) de jeu
du W5/W7?

Le nom du morceau est affiché sur
I'écran, mais les données de
séquences de morceau sont
inaccessibles

* Les parametres de multis de morceaux (dont le nom de morceau) sont conservés méme si
l'appareil est mis hors tension. Toutefois, les données de séquences de morceaux (ainsi que les
données de sonorités de morceaux) seront perdues lorsque le W5/W?7 est mis hors tension.



Unknown
 

Unknown
 


La carte d’extension d’ondes et de sonorités (en option) du W5/W7 vous fournit 4
méga-octets de sonorités et d’éléments AWM supplémentaires. (REMARQUE: Pour obtenir
des renseignements au sujet des types de cartes disponibles, veuillez vous adresser a votre
revendeur Yamaha le plus proche.)

REMARQUE IMPORTANTE: Attention! Installer la carte d’extension d'ondes et de sonorités pourrait effacer la mémoire
interne. Veillez a sauvegarder sur disquette toutes les données internes avant d'installer la carte.

INSTALLER LA CARTE

Pour installer la carte d’extension d’ondes et de sonorités,
veuillez suivre les étapes suivantes.

1. METTRE LE W5/W7 HORS TEN-
SICON

Mettez le W5/W7 hors tension et débranchez le cordon
d’alimentation de la prise secteur.

2. PLACER LE W5/W7 SUR UNE SUR-
FACE PLANE ET STABLE

Placez le W5/W7 (retourné) sur une table solide ou sur
toute autre surface de niveau. (Pour éviter de griffer la
finition de Tinstrument, couvrez d'abord la table d'une
couverture ou d’'une épaisse serviette.)

3. OTER LE COUVERCLE

A laide d’'un tournevis cruciforme , dévissez les huit vis
maintenant le couvercle carré en place. Otez le couvercle
comme indiqué sur l'illustration. Soyez extrémement
prudent lors de cette opération : ne perdez pas de vis ou
quelque objet dans le boitier du W5/W7.

@ ® \
>
[©] ®
= [ = [ ] J
I I
Devant

4. INSTALLER LA CARTE

Tout en tenant la carte par ses extrémités, assurez-vous
que les deux bornes de la carte d'extension sont dans le
sens correspondant aux deux ports de la carte de circuits
du W5/W7. Placez ensuite la carte d'extension sur les
quatre pattes de fixation (voir l'illlustration) et insérez
précautionneusement la carte en appliquant une
pression identique sur les quatre coins de la carte. La
carte devrait alors se mettre en place (un léger “clic”

vous indiquera quelle est bien en place). N'appliquez
pas de pression excessive sur la carte.

S5b
- 91,
>

Devant

5. REMETTRE LE COUVERCLE EN
PLACE

Une fois que la carte est correctement installée, I'opéra-

tion d'installation est effectuée. Replacez le couvercle
carré sur lorifice d’acces et revisser les huit vis.
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DESCRIPTION

Easy operation professional music production workstation featuring synthesizer, sequencer,
full voice and song editing capabilities, large memory capacity and GM compatibility
TONE GENERATOR

AWM2 (2nd Generation Advanced Wave Memory): 16 bit linear waveform data,
maximum 48kHz sampling frequency

Maximum simultaneous notes: 32
Maximum simultaneous timbres: 1 (Voice Mode), 16 (Song Multi Play Mode)
Note assignment: Last note priority

KEYBOARD

WS5: 76 notes, key velocity sensitivity, aftertouch
W7: 61 notes, key velocity sensitivity, aftertouch

DSP EFFECTS

Insertion Effects modules (35 effects): Stereo in/out module, Mono in/Stereo out module,
Mono in/out module

3 System Effects 1, 2, 3modules (40 effects): Reverb module, Chorus module, Delay/Reverb module

SEQUENCER
Tracks: 16
Songs: 16
Resolution: 1/96 of a quarter note (for internal clock), 1/96 of a quarter note (for MIDI sync)
Maximum simultaneous notes: 32
Capacity: Approximately 100,000 notes
Recording: Realtime, Step, Punch-in
Editing: Event Change, Event Insert, Song Jobs
Format: Song (Load/Save), SMF Format-0 (Load/Save), SMF Format-1 (Load), ESEQ (Load)

MEMORY
Preset waves: 8Mbytes
GM voices: 128 (normal) + 8 (drum)
Preset voices: 128 (normal) + 2 (drum)
Internal voices: 128 (normal) + 2 (drum)
Song voices: 128 (normal) + 2 (drum) x 16
External voices (option):
Disk: drive 3.5” 2DD type floppy disk (9 sector, 720kbyte formatted)
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CONTROLLERS
Wheels: Pitch Bend, Modulation
Sliders: Volume, Continuous (CS)
Dials: Jog/Shuttle

Panel switches: Song Mode; Voice Mode; Edit Mode; Utility Mode; Job Mode; Disk Mode; Store;
Voice Edit; Track Select; Solo; Track x 16; Sequencer Record, Stop/Top, Run; Shift; Function x 8;
Exit; Numeric Keypad [0 ~ 9], Negative value (-], Enter; Cancel; Data/Cursor; Increment [INC;
Decrement [DEC]; Cursor-up, -down, -left, -right

DISPLAY
LCD: 240 x 64 dot (with contrast adjust)

LED: 20 (square), 8 (round)

TERMINALS
Audio output: Output (L/Mono, R), Phones

Foot pedals: Sustain, Foot Controller, Foot Volume,
MIDI: IN, OUT, THRU

POWER REQUIREMENTS
USA and Canadian models: 120V
General model: 220 ~ 240V

POWER CONSUMPTION
20 watts

OUTPUT IMPEDANCE
Output: +6.5 dBm (10 kQ)
Phones: +13 dBm (150 Q), +7.5 dBm (33 £2)
DIMENSIONS
W5: 1288(W) x 371(D) x 121(H) mm (50-3/4" X 14-1/2" X 4-3/4”)
W7: 1067(W) x 371(D) x 121(H) mm (42” X 14-1/2” X 4-3/4")

WEIGHT
W5: 18 kg (39-1/2 Ibs.)
W7: 14 kg (30-1/2 1bs.)

INCLUDED ACCESSORIES
Factory Set & Demonstration Disk, AC Power Cable

Les caractéristiques et descriptions sont données dans ce manuel de Vutilisateur a titre d'information seulement.
Yamaha Corp. se réserve le droit de modifier le produit ou les spécifications techniques d tout moment et ce sans avis préalable.
Vu que les spécifications techniques, I'équipement et les options peuvent differer selon lendroit, veuillez consulter votre revendeur Yamaha pour obtenir plus de détails.
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ACCORDAGE, parametre de touche des sonorités rythmiques, 126,
comment y accéder, 78, accordage global, 78, mode d’édition des
sonorités normales, 118, hauteur de son, 118, écran de multis de
morceaux, 37

ACCORDAGE GENERAL, comment y accéder, 78, configuration du
synthétiseur, 145

ACTIVATION/DESACTIVATION D’ELEMENT, 109

ACTIVATION DE L'ENREGISTREMENT PAS A PAS, enregistrement pas
a pas, 89

AEG, voir générateur d’enveloppe d'amplitude
ALEATOIRE, accordage de hauteur, 118

AMD, voir profondeur de la modulation d’amplitude
AMP, voir amplitude

AMPLITUDE, acces aux parametres d’amplitude, 113, mode d’édition de
sonorités normales, 113, sensibilité a la vélocité, 113

AMPLITUDE DE TYPE “TEMPLATE", 113

ANNEXE DE MORCEAU, opération de morceau (Song job) 1, 96
ANNULATION, voir touche “Cancel”

APERCU GENERAL DU SYSTEME, diagramme, 18

APPENDICE, 151

APPRENTISSAGE, comment démarrer, 43

APRES-TOUCHER, description de la commande d'apres-toucher du
clavier, 51, controleur d’élément, 122, insertion de données d’apres-
toucher, 94

APRES-TOUCHER, PLAGE DE PITCH BEND, controleur de pitch bend,
122

ARMATURE DE TEMPS, description, 80, mode d'enregistrement des
morceaux, 86

ARRET DE L'ENREGISTREMENT PAS A PAS, enregistrement pas a pas,
90

ASSIGNATION, assignation du curseur linéaire CS, 147, assignation
déléments aux touches en sonorités rythmiques, 125, assignation
d’éléments pour les sonorités normales, 112

ASSIGNATION (S, controleurs du mode utilitaire, 147

ASSIGNATION D’ELEMENTS, parametre d'élément des sonorités
normales, 112

ASSIGNATION DE TOUCHE, parametre de touche pour les sonorités
rythmiques, 125

ASSIGNATION DE VOLUME A LA COMMANDE AU PIED, controleurs
du mode utilitaire, 147

ASSOURDISSEMENT, mise en solo et assourdissement d'instruments,
55, mise en solo et assourdissement de piste, 74

AUTRES, autres configurations du mode utilitaire, 149

AUTRES CONFIGURATIONS, acces aux autres configurations, 149,
confirmation d'édition activée/désactivée, 149, comment y accéder,
84, contraste écran, 149, controle MIDI, 84, morceau suivant, 84,
synchronisation, 84, transposition, 84, mode utilitaire, 149

AUTRES CONFIGURATIONS DE MORCEAUX, comment y accéder, 84
AVANT DE COMMENCER, section d'introduction, 7

AWM, diagramme des éléments, 30, apercu général, 30, génération de
sons, 104

BANDE, sensibilité de 1a bande de vitesse de filtre, 116
BANQUIE, banque d’¢léments de sonorités normales, 112

BANQUE DE SONORITES INTERNES, rappel des sonorités internes
pré-programmeées d'usine, 144, rechargement des données de
sonorités programmeées d'usine, 66

BANQUES D’ELEMENTS, parametre d'élément des sonorités normales,
112

BANQUES DE SONORITES, tableau des listes de sonorités et description
de chacune, 49, description et liste des types, 25, comment les
sélectionner 48, comment les sélectionner, 78, rechargement des
données de sonorités programmées a l'usine, 66

BANQUES DE SONORITES NORMALES, tableau avec listes des
sonorités et description de chacune, 49

BANQUES DE SONORITES RYTHMIQUES, tableau des listes et
description de chacune, 49

BARRE DE MESURES, graphique des pistes de séquences, 91, insertion
de données de séquences/de tempo pour les pistes, 94, enregistre-
ment pas a pas, 89

BATTEMENT, insertion de données de séquences/de tempo pour les
pistes, 94

BEF (Filtre d¢limination de bande), filtre, 115
BORNE DE SUSTAIN, description et diagramme du panneau arriére, 15

BORNE FOOT CONTROLLER, description et diagramme du panneau
arriere, 16

BORNES, borne de la commande au pied “FOOT CONTROLLER”, borne
de pédale de volume, connecteurs MIDI, borne du casque d'écoute
“PHONES”, bornes de sortie stéréo, borne de sustain, 16

BORNES DE SORTIE STEREOQ, description et diagramme du panneau
arriere, 16

BPF (Filtre passe-bande), filtre, 115

C

CANAL DE TRANSMISSION DE PISTE, activation/désactivation externe,
82, activation/désactivation interne, 82, canal de transmission MIDI,
82, numéro de piste, 82

CAPACITE DE NOTES, sonorités d'instruments et polyphonie, 25,
capacité de notes simultanées, 74

CARTE D’EXTENSION D'ONDES/DE SONORITES, comment l'installer,
155

CATEGORIE DE SONORITE, définition et liste des types, 27, dia-
gramme, 47, parameétre commun pour les sonorités rythmiques,
125, parametre commun pour les sonorités normales, 110

CHANGEMENT, changement de données, 92, changement de données
de séquences/de tempo pour les pistes, 92

CHANGEMENT DE CONTROLE, insertion de données de changement
de controle, 94

CHANGEMENT DE DONNEES, acces au changement de données, 92,
changement de données, 92, localisation de données, 92, change-
ment de données de séquences/de tempo pour les pistes, 92

CHANGEMENT DE DONNEES, changement de données de sequences/
de tempo pour les pistes, 92

CHANGEMENT DE DONNEES DE PISTES, changement de données de
tempo/de séquences pour les pistes, 92



CHANGEMENT DE DONNEES DE SEQUENCES/DE TEMPO POUR
UNE PISTE, référence des fonctions, 92

CHANGEMENT DE DONNEES DE TEMPO POUR LES PISTES,
comment accéder a la fonction, 93

CHANGEMENT DE NOTE, opération de morceau Song Job 3, 103

CHANGEMENT DE NOTE, parametre de touche des sonorités
rythmiques, 126, comment y accéder, 78, changement de note
global, 78, mode d’édition de sonorités normales, 118, écran de
multis de morceaux, 37

CHANGEMENT DE NOTE GLOBAL, comment y accéder, 78

CHANGEMENT DE PROGRAMME, insertion de données de change-
ment de programme, 94, configurations MIDI, 148

CHANGEMENT DE TEMPO, insertion de données de tempo dans une
piste, 94

CHANGEMENT DU TEMPO, comment démarrer, 55

CHARGEMENT ET JEU DE LA DEMONSTRATION, comment
démarrer, 52

CLAVIER, mode de partage en 4 zones, 83, description et diagramme du
panneau avant, 12, controle d'aprés-toucher du clavier, 51, échelle
de hauteur de son du clavier, 117, mode superposé, 83, activation/
désactivation locale, 148, mode

normal, 83, graphique des pistes de séquences, 91, mode de partage, 83,
point de partage, 83, entrée de données en enregistrement pas a pas,
90, valeur de la vélocité dans l'enregistrement pas a pas, 90.

CLIC, sélection de battement du clic sonore, 80, 87, sélection du niveau
du clic, 81, 87, sélection du mode de clic, 80, 87

CLOCK, insertion de données de séquences/de tempo pour les pistes, 94

COMMANDE AU PIED, controleur, 123, description du controle de la
commande au pied, 50, valeur initiale de la commande au pied, 147

COMMANDE D'EFFET D'INSERTION, mode d’édition des sonorités
rythmiques, 127, mode d’édition des sonorités normales, 120

COMMANDE DU SON, controle du son, 31
COMMANDE EN TEMPS REEL, controleurs, 50

COMMANDES DU SEQUENCEUR, comment démarrer, 61, utilisation
des commandes du séquenceur, 86

COMMENT DEMARRER, section d’apprentissage, 43
COMMENT UTILISER CE MANUEL, 4
COMMON voir “commun”

COMMUN, acces aux parametres communs des sonorités rythmiques,
125, acces aux parametres communs des sonorités normales, 110,
parametre commun des sonorités rythmiques, 125, valeurs de re-
initialisation communes pour les sonorités normales, 110, paramétre
commun des sonorités normales, 110

COMMUTATEUR D’EFFET D'INSERTION, mélangeur, 77, écran de
multis de morceaux “Song Multi”, 36

COMPARAISON, comparaison/édition des sonorités, 108
CONFIGURATION DU CLAVIER, comment y accéder, 82
CONFIGURATION DU SYNTHE, voir configuration du synthétiseur

CONFIGURATION DU SYNTHETISEUR, acces aux configurations du
synthétiseurs, 145, controleur, 145, accordage global, 145, mode
utilitaire, 145, courbe de vélocité, 145, vélocité, 145

CONFIGURATIONS, configurations MIDI, 148, création de morceaux,
82, autres configurations du mode utilitaire, 149

CONFIGURATIONS MIDI, acces aux configurations MIDI, 148, numéro
de dispositif, 148, activation/désactivation locale du clavier, 148,
changement de programme, 148, mode utilitaire, 148

CONFIRMATION, activation/désactivation de la fonction de confirma-
tion d’édition, 149

CONFIRMATION D’EDITION, autres configurations du mode utilitaire,
149

CONNECTEUR D'ALIMENTATION, description et diagramme du
panneau arriére, 15

CONNECTEURS MIDI, description et diagramme du panneau arriere,
15

CONNEXION A UN SYSTEME DE SURVEILLANCE, comment
démarrer, 44

CONSERVATION, copie de sauvegarde de données et conservation, 5

CONTRASTE DE L’ECRAN, autres configurations du mode utilitaire,
149

CONTROLE, controle de l'effet d’'insertion des sonorités normales, 120,
controle

en temps réel, 50, controle des sonorités, 105
CONTROLE DES SONORITES, maniere de contrdler une sonorité, 103,
CONTROLE DU SON, fonctions de contréle du son, 31

CONTROLE MIDI 1/2, controleur de sonorité rythmique, 128,
contrdleur de sonorité normale, 124

CONTROLES, controles du séquenceur, 61

CONTROLEUR, acces aux parametres des controleurs des sonorités
rythmiques, 128, accés aux parametres des controleurs des sonorités
normales, 122, plage de pitch bend de l'apres-toucher, 122, apres-
toucher, 122, profondeur de la modulation d'amplitude, 122,
section des contrdleurs, 22, coupure, 22, mode d'édition des
sonorités rythmiques, 128, controle MIDI des sonorités rythmiques,
128, distorsion du générateur d'enveloppe, 122, limite inférieure
d’expression, 122, profondeur de modulation du filtre, 122,
commande au pied, 50, mode de clavier partagé en 4 zones, 84,
mode d'édition des sonorités normales, 122, controle MIDI des
sonorités normales, 124, plage de pitch bend, 122, pitch bend, 122,
profondeur de modulation de la hauteur de son, 122, sustain, 122,
configurations du synthétiseur, 145

CONTROLEURS, acces aux controleurs, 147, tableau des controleurs de
typecontinu, 147, assignation du curseur linéaire CS, 147, descrip-
tion, 32, valeur initiale de la commande au pied, 147, assignation de
la pédale de volume, 147, tableau des types désactivés/activés, 147,
controle en temps réel, 50, mode utilitaire, 147

COPIE DE MESURES, opération de morceau Song Job 2, 98
COPIE DE MORCEAU, opération de morceau Song Job 1, 96
COPIE DE PISTE, opération de morceau Song Job 1, 97

COPIE DE SAUVEGARDE, copie de sauvegarde des données et
conservation, 5

COPIE DE SAUVEGARDE DE DONNEES ET CONSERVATION,
précautions a prendre, 5

COUPURE, controleur d’apres-toucher, 122, filtre, 116, commande au
pied, 123, contrdleur de la molette de modulation, 123

COUPURE DE FILTRE, 116

COURBE, configuration de courbe de vélocité du synthétiseur, 145
COURBE DE VELOCITE, configuration du synthétiseur, 145
CREATION DE MESURE, opération de morceau Song Job 2, 98
CREATION DE MORCEAUX, 82

CREATION DE MORCEAUX, référence des fonctions, 82, comment y
accéder, 82, configuration du clavier, 82, autres configurations, 84,
filtre de restitution, 82, canal de transmission des pistes, 82

CRESCENDO, opération de morceau Song Job 3, 103
CS, voir curseur linéaire

CURSEUR, position du curseur a la mise sous tension, 46, description et
diagramme du panneau avant, 14, comment l'utiliser, 42, emplace-
ment lors de la sélection de pistes et de fonctions, 46

CURSEUR DE VOLUME, description et diagramme du panneau avant,
12
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CURSEUR LINEAIRE, assignation du curseur linéaire CS, 147, descrip-
tion de la commande de curseur linéaire, 50, description et
diagramme du panneau avant, 12

D

DEBUT DE LA PISTE, changement de données de séquences/de tempo
pour les pistes, 92

DECALAGE, changement de hauteur de note de I'élément, 118
DECAY, voir estompement

DEFAIRE, opération de morceau Song Job, défaire/refaire, 95
DEFILEMENT, entrée de données en enregistrement pas a pas, 90

DEFINITION D'UN MULTI DE MORCEAU OU “SONG MULTT",
différentes étapes de la procédure, 74

DELAY, voir retard
DEPLACEMENT D’'HORLOGE, opération de morceau Song Job 3, 101

DIAGRAMME, des éléments AWM, 30, 104, panneau avant, 10, effets
d'insertion et du systeme, 28, canaux du mélangeur pour les
sonorités normales et rythmiques, 24, sonorités rythmiques et
normales, 106, écran de multis de morceaux, 76, diagramme et
apercu général du systeme, 18, tableau des banques de sonorités, 49,
catégories de sonorités, 27, 47

DIRECTORY, voir répertoire
DISQUE, description du mode disque, 40, mode disque, 131

DISQUETTE “FACTORY SET & DEMONSTRATION”, chargement des
morceaux de démonstration, 52, rechargement des données de
sonorités pré-établies d’usine, 66

DISTORSION, distorsion du générateur d'enveloppe sur les éléments
avec le controleur d’aprés-toucher, 122

DISTORSION DU GENERATEUR D'ENVELOPPE, controleur d'apres-
toucher, 122, commande au pied, 123, controleur de la molette de
modulation, 123

DONNEES, sauvegarde et mémorisation, 5, effacement de données, 92,
méthodes et fonctions dentrées de données, 41, pavé numérique
d'entrée de données, 42, déplacement de données, 92, comment
sauvegarder et charger des données, 64, insertion de données, 94,
modes et fonctions de gestion des données, 38, nouvelle valeur de
données, 92, organisation et gestion des données, 65, réception de
blocs de données de sonorités, 144, changement de données de
séquences/de tempo pour les pistes, 92, insertion de données de
séquences/de tempo sur les pistes, 93, entrée de données dans
I'enregistrement pas a pas, 90, types de données pouvant étre
modifiées, 93, transfert de blocs de données de sonorités, 144.

DONNEES DE SONORITES, rechargement des données de sonorités
programmées a I'usine, 66

DONNEES MUSICALES, copie de sauvegarde et conservation, 5,
comment sauvegarder et charger des données, 64, organisation et
gestion des données, 65

E

ECHELLE, hauteur, 117
ECHELLE DE HAUTEUR DU CLAVIER, 117

ECRAN, informations d'entrée de données, 41, description et diagramme
du panneau avant, 13

ECRAN DE MULTIS DE MORCEAUX, référence des fonctions, 76

EDITION, acces aux parametres d’édition des sonorités rythmiques, 124,
acces aux parametres d’édition des sonorités normales, 109,
confirmation d'édition activée-désactivée, 149, édition d’une
sonorité, 108, mode d’édition de sonorités normales, 109, 124,
différentes étapes dans I'édition de sonorités, 58, comparaison/
édition des sonorités, 108, apercu général de I'¢dition des sonorités,
33

EDITION/COMPARAISON, édition/comparaison des sonorités, 108
EDITION D’'UNE SONORITE, 108

EDITION DE SONORITES, acces aux parametres d’édition des sonorités
rythmiques, 124, acces aux parametres d'édition des sonorités
normales, 109, mode d'édition des sonorités rythmiques, 124, mode
d'edition des sonorités normales, 109, apercu général, 33, différentes
phases dans T'édition d'une sonorité, 58

EFFACEMENT, effacement de données, 92, effacement de notes sur le
graphique de séquences de pistes, 91, effacement arriere dans
l'enregistrement pas a pas, 90, enregistrement pas a pas 90

EFFACEMENT ARRIERE, enregistrement pas 2 pas, 90
EFFACEMENT DE FICHIER, mode disque, 140

EFFACEMENT DE MESURE, opération de morceau Song Job 2, 98
EFFACEMENT DE MESURE, opération de morceau Song Job 2, 99
EFFACEMENT DE MORCEAU, opération de morceau Song Job 1, 96
EFFACEMENT DE PISTE, opération de morceau Song Job 1, 97

EFFET, acces aux parametres deffets des sonorités rythmiques, 127,
acces aux parametres d'effets des sonorités normales, 119, mode
d'édition des sonorités rythmiques, 127, mode deffet des sonorités
rythmiques, 127, parametre d'insertion d'effet pour les sonorités
rythmiques, 127, type d’effet d’insertion pour les sonorités
rythmiques, 127, commutateur d'effets d'insertion du mélangeur,
77, niveau de retour principal du mélangeur, 77, envoi des effets du
systeme au mélangeur, 77, mode d’édition des sonorités

normales, 119, mode d'effet des sonorités normales, 119, controle de
leffet d'insertion des sonorités normales, 120, écran de multis de
morceaux, 36, niveau d’envoi pour les effets du systeme des
sonorités rythmiques, 127, niveau d’envoi pour les effets du systeme
des sonorités normales, 119, sélection des parametres deffets du
systeme, 78, parametres d'effets du systeme, 79, sélection du type
deffets du systeme, 77, type deffets du systeme, 79

EFFET D'INSERTION, description, 29, parametre d'effet d'insertion des
sonorités rythmiques, 127, type d’effet d'insertion des sonorités
rythmiques, 127, commutateur d'effet d'insertion du mélangeur, 77,
diagramme de multis, 28, commande d'effet d'insertion pour les
sonorités normales, 120, parametre d’effet d’insertion pour les
sonorités normales, 120, type deffet d'insertion pour les sonorités
normales, 119

EFFETS DU SYSTEME, description, 29, niveau d'envoi des sonorités
rythmiques, 127, niveau d'envoi des effets du systeme pour les
sonorités rythmiques, 126, référence des fonctions, 79, envois
d'effets du systeme au melangeur, 77, diagramme de multis, 28,
niveau d’envoi des sonorités normales, 119, sélection de type d’effet
du systeme, 77, sélection des parametres d'eflets du systeme, 78

EG, voir générateur d’enveloppe
ELAGAGE (thin out), opération de morceaux Song Job 2, 99

ELEMENT, acces aux parametres de filtre, 116, acces aux parametres
d'éléments pour les sonorités normales, 112, générateur d’enveloppe
d'amplitude, 114, sensibilité a la vélocité de Yamplitude, 113,
amplitude, 113, description et diagramme, 104, diagramme, 30,
sélection de banque d’éléments pour les sonorités rythmiques, 125,
sélection du numero d'élément pour les sonorités rythmiques, 126,
assignation d'éléments aux touches pour les sonorités rythmiques,
125, affichage des éléments, 109, sensibilité des éléments a la
hauteur de son, 118, générateur d'enveloppe de filtre, 116, filtre,
115, oscillateur basses fréquences (LFO), 121, mode d'édition des
sonorités normales, 112, assignation d’éléments aux sonorités
normales, 112, banque d'éléments pour les sonorités normales, 112,
valeurs de ré-initialisation des éléments des sonorités normales, 111,
nombre d'éléments des sonorités normales, 112, panoramiques des
éléements des sonorités normales, 112, limite de note des sonorités
normales, 113, limite de vélocité pour les sonorités normales, 112,
changement de note, 118, générateur d’enveloppe de hauteur, 118,
hauteur de son, 117, sélection des éléments, 109, activation/
désactivation des éléments, 109, accordage, 118

ELEMENTS AWM, description et diagramme, 104
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ENREGISTREMENT, toutes les pistes, 87, toutes les pistes, 88, overdub,
88, préparation pour l'eniregistrement en temps réel, 89, préparation
pour l'enregistrement pas a pas, 89, fonctionnement en temps réel,
88, remplacement, 88, phases pour 'enregistrement d’'un morceau,
85

ENREGISTREMENT DE MORCEAUX, acces a une fonction ou a un
parametre d’enregistrement de morceaux, 86

ENREGISTREMENT EN TEMPS REEL, toutes les pistes, 87, toutes les
pistes, 88, référence des fonctions, 87, overdub, 88, préparation
pour, 88, fonctionnement en temps réel, 88, remplacement, 88

ENREGISTREMENT PAS A PAS, effacement arriere, 90, entrée de
données, 90, effacement 90, référence des fonctions, 89, forte, 90,
visualisation du clavier, 90, clavier, 90, mezzo forte, 90, normal, 90,
longueur de note, 90, piano, 90, préparation pour, 89, liaison, 90,
staccato, 90, arrét de pas, 90, valeurs de veélocité, 90

ENTREE DE DONNEES, enregistrement pas a pas, 90, comment y
accéder, 93, insertion de données, 93, localisation de données, 93,
insertion de données de séquences/de tempo sur les pistes, 93

ENTREE DE DONNEES, pavé numérique d'entrée de données, 14,
différentes fonctions et méthodes d’entrée de données, 41

ENVOI, niveau d'envoi des effets du systeme pour les sonorités
rythmiques, 126, 127, niveau d’envoi des effets du systeme du
mélangeur, 77, niveau d'envoi des effets du systeme pour les
sonorités normales, 119, réglage de niveau d'envoi des sonorités
pour les effets du systeme, 77, niveau d’envoi de sonorités pour les
effets du systeme, 80

ESEQ, chargement 2 partir d’'une disquette, 137

ESTOMPEMENT, parametre de touche pour les sonorités rythmiques,
126

EXPLORATION DES OPTIONS DE RESTITUTION DE MORCEAUX,
comment démarrer, 54

EXPLORATION DES SONORITES PRE-PROGRAMMEES, comment
démarrer, 45

EXPRESSION, assignation a la pédale de volume, 147
EXTRACTION, opération de morceau Song Job 2, 99

F

FEG, voir générateur d’enveloppe de filtre

FICHIER, répertoire de fichiers, 132, nom de fichier, 132, sélection des
fichiers, 132

FILTRE, accés aux parametres de filtre, 116, mode d'édition des sonorités
normales, 115, filtre de configurations de morceaux MIDI, 82, ton,
116

FILTRE MIDI, comment y accéder, 82

FIN DE PISTE, changement de données de séquences/de tempo pour les
pistes, 92

FIXE, changement de hauteur de note des ¢léments, 118

FMD, voir profondeur de modulation du filtre

FONCTION DE CREATION DE MORCEAU, description, 73
FONCTION DE JEU DE MULTIS DE MORCEAUX, description, 73
FONCTION DE JEU DE SEQUENCES DE MORCEAUX, description, 73

FONCTIONNEMENT EN TEMPS REEL, enregistrement en temps réel,
88

FORMATAGE DE DISQUETTES, mode disque, 141

FORTE, valeur de vélocité dans l'enregistrement pas a pas, 90

G

GENERAL MIDI, au sujet du niveau 1 du systeme Général MIDI, 8, piste
de sonorités rythmiques et, 45 et réglage pour les messages SysEx,
94

GENERATEUR D'ENVELOPPE (EG), générateur d'enveloppe d’ampli-
tude, 114, description, 31, générateur d’enveloppe de filtre, 116,
générateur d'enveloppe de hauteur de son, 118

GENERATEUR D’ENVELOPPE D’AMPLITUDE, mode d'édition de
sonorités normales, 114

GENERATEUR D’ENVELOPPE DE FILTRE, mode d’¢dition des sonorités
normales, 116

GENERATEUR D’)ENVELOPPE DE HAUTEUR, 118
GENERATEUR DE SONS, section du générateur de sons, 22
GENERATION DE SONS, génération de sons AWM?2, 30, 104

GENERATION DE SONS AWM, apercu général et tableau des
¢léments,30, référence des fonctions, 104

GRAPHIQUE, graphique des pistes de séquences, 91
GRAPHIQUE DE PISTES DE SEQUENCES, référence des fonctions, 91

GROUPE ALTERNATIF, parametre de touche de la sonorité rythmique,
126

GUIDE DE DEPANNAGE, appendice, 153

H

HAUTEUR, acces aux parametres de hauteur, 117, générateur d’enve-
loppe, 118, mode d’édition de sonorités normales, 117, échelle, 117,
sensibilité, 118, type template, 117, accordage, 118

HPF (FILTRE PASSE BANDE), filtre, 115

I

INSERTION, insertion de données, 93, insertion de données de
séquences/de tempo pour une piste, 93

INSERTION DE DONNEES DE SEQUENCES/DE TEMPO POUR UNE
PISTE, référence des fonctions, 93

INSERTION DE DONNEES DE TEMPO POUR LES PISTES, comment
accéder a la fonction, 94

INSERTION DE DONNEES SUR LES PISTES, insertion de données de
tempo/de séquences sur les pistes, 93

INSERTION DE MESURES, opération de morceau Song Job 2, 99
INSTALLATION ET JEU, comment démarrer, 44

INSTRUMENT, affichage des parametres d'instrument, 63, Sélection des
parametres d'instrument, 63, sélection des pistes instrumentales, 63,
affichage des parametres d'instrument, 75, sélection des parametres
d'instrument, 75, sélection des pistes instrumentales, 75

INTERRUPTEUR D'ALIMENTATION, description et diagramme du
panneau arriere, 15

J

JEU DE SEQUENCES DE MORCEAU, référence des fonctions, 80,
comment y accéder, 80

JOB, mode d'opérations de morceaux “song job”, 95
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L

LCD, informations d'entrée de données, 41
LECTEUR DE DISQUETTES, comment l'utiliser et en prendre soin, 6

LECTEUR DE DISQUETTES, description et diagramme du panneau
avant, 12, comment l'utiliser et en prendre soin, 6

LFO, acces aux parametres LFO, 121, profondeur de la modulation
d'amplitude, 121, profondeur de la modulation de filtre, 121,
description oscillateur basses fréquences, 32, modulation, 121,
mode d'édition de sonorités normales, 121, profondeur de
modulation de hauteur de son, 121

LIAISON, enregistrement pas a pas, 89

LIMITE, limite de note d’élément pour les sonorités normales, 113, limite
de vélocité d'élément pour les sonorités normales, 112

LIMITE DE NOTE, limite de note pour les éléments de sonorités
normales, 113

LIMITE DE NOTE DES ELEMENTS, sonorités normales, 113

LIMITE DE VELOCITE, parametre d'élément pour les sonorités
normales, 112

LIMITE DE VELOCITE DES ELEMENTS, parametre d'élément des
sonorités normales, 112

LIMITE INFERIEURE, mode de clavier en 4 zones, 83
LIMITE INFERIEURE D’EXPRESSION, controleur de batterie, 128

LIMITE INFERIEURE D'EXPRESSION, controleur de sustain pour les
sonorités normales, 122

LIMITE SUPERIEURE, mode de partage du clavier en 4 zones, 83

“LOAD FROM DISK” (CHARGEMENT A PARTIR DE DISQUETTE),
acces 2 la fonction de chargement a partir de disquette, 136, tout
charger, 136, mode disque, 136, chargement d’un morceau, 136,
chargement d'un morceau + sonorité, 137, chargement de données
ESEQ/SMF, 137, chargement de sonorité, 138

LOCALE, activation/désactivation locale du clavier, 148
LOGIQUE DU SYSTEME, 17

LONGUEUR DE NOTE, enregistrement pas a pas, 90
LPF (FILTRE PASSE-BANDE), filtre, 115

M

MAINTIEN, controleur de configuration du synthétiseur, 145
MELANGE DE PISTES, opération de morceaux Song Job 1, 97
MELANGE DE SONS, apercu général, 35

MELANGEUR, accordage fin du mélange stéréo, 63, diagramme des
canaux du mélangeur, 24, mélange de sons, 35, mélangeur du
générateur de sons, 22

MEMOIRE, acces a la mémoire de sonorités de morceaux, 143, jauge de
mémoire disponible, 76, copie en mémoire de sonorités de
morceaux, 143, capacité de mémoire, 38, modes et fonctions pour la
gestion des données, 38, sélection d’une mémoire de sonorité de
morceaux, 143, mémoire de sonorité de morceaux, 143, banques de
mémoires volatiles et non volatiles, 38

MEMOIRE DE SONORITES DE MORCEAUX, acces a la mémoire de
sonorités de morceaux, 143, copie dans la mémoire de sonorités de
morceaux, 143, description et gestion des sonorités de morceaux,
38, sélection d’'une mémoire de sonorité de morceau,

143, mode utilitaire, 143

MEMOIRE DISPONIBLE, 76

MESSAGE DE BIENVENUE, mode utilitaire, 149
MESSAGES D’ERREUR, appendice, 152

MESURE, assignation de localisation de mesure, 81, localisation de
mesure, 81, marque de mesure, 92, sélection de mesure, 80,
sélection de mesure, 86.

MEZZO FORTE, valeur de vélocité dans l'enregistrement pas a pas, 90

MIDI, informations concernant le niveau du systeme Général MIDI, 8,
contréle d'autres dispositifs, 67, numéro de dispositif, 148, piste
rythmique et le Général MIDI, 45, intégration du W5/W?7 dans un
systeme MIDI, 67, activation/désactivation locale du clavier, 148,
Canal MIDVpiste d’instrument, 76, filtre MIDI, 82, configurations
MIDI, 148, changement de programme, 148, asservi a d'autres
dispositifs, 69, controle des autres configurations MIDI de mor-
ceaux, 84, élément du systeme, 68, canal de transmission, 82

MISE EN SEQUENCE DE MORCEAUX, accés a un parametre ou a une
fonction d’enregistrement de morceaux, 86, aperqu général, 34,
phases dans la création d’une séquence de morceau, 61

MISE EN SEQUENCES, acces 4 une fonction ou a un paramétre
d'enregistrement de morceau, 86, création de séquences de
morceaux, 61, apercu de la mise en séquence de morceaux, 34

MISE EN SOLO ET ASSOURDISSEMENT DES INSTRUMENTS,
comment démarrer, 55

MIXAGE, accordage fin du mélange stéréo, 63, mélange de sons, 35

MODE DEDITION DE SONORITES NORMALES, accés aux parametres
d’édition de sonorités normales, 109, effet, 119, entrée et sortie du
mode d’édition de sonorités normales, 109, réféerence des fonctions,
109

MODE D’EDITION DES SONORITES, accés aux paramétres de filtre,
116, acces aux parametres d’édition des sonorités normales, 109,
amplitude, 113, contréleur de sonorités rythmiques, 128, mode
d'édition des sonorités rythmiques, 124, effet des sonorités
rythmiques, 127, changement de note des éléments, 118, référence
des fonctions, 108, générateur d'enveloppe de filtre, 116, filtre, 115,
LFO, 121, controleur de sonorités normales, 122, mode d’édition
des sonorités normales, 109, effet des sonorités normales, 119,
description des modes de fonctionnement, 20, hauteur de son, 117

MODE D'EDITION DES SONORITES, entrée et sortie du mode d’édition
des sonorités, 91, référence des fonctions, 91, description des modes
de fonctionnement, 19, apercu général, 72, graphique de pistes de
séquences, 91

MODE D'EDITION DES SONORITES RYTHMIQUES, acceés aux
parametres d'édition des sonorités, 124, effet, 127, entrée et sortie
du mode d’édition des sonorités, 124, mode d'édition des sonorités,
124.

MODE D'EFFETS, type d'effets d'insertion pour les sonorités rythmiques,
127, type d'effets d'insertion pour les sonorités normales, 119

MODE D’ENREGISTREMENT DE MORCEAUX, entrée et sortie du
mode d'enregistrement de morceaux, 85, référence des fonctions,
85, description des modes de fonctionnement, 19, apercu général,
72, phases de l'enregistrement d’'un morceau, 85

MODE D’OPERATIONS DE MORCEAUX, entrée et sortie du mode
d'opérations de morceaux Song Job, 95, référence des fonctions, 95,
déplacement au sein du mode d'opérations de morceaux, 95,
description des modes de fonctionnement, 20, apercu général, 72,
défaire/refaire, 95

MODE DE JEU DE MULTIS DE MORCEAUX, statut & la mise sous
tension, 45

MODE DE JEU DES MORCEAUX, référence des fonctions, 73,
description des modes de fonctionnement, 19, apercu général, 72

MODE DE JEU DES SONORITES, acces aux fonctions de jeu des
sonorités, 107, entrée et sortie du mode de jeu des sonorités, 107,
référence des fonctions, 107, description des modes de fonctionne-
ment, 20

MODE DE MORCFEAUX, référence des fonctions, 72, description des
modes de fonctionnement, 19

MODE DE SAUVEGARDE, entrée et sortie du mode de sauvegarde, 129,
référence des fonctions, 129, descrintion des modes de fonctionne-
ment, 21
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MODE DE SONOQRITES, référence des fonctions, 106, description des
modes de fonctionnement, 20

MODE DISQUE, acces aux fonctions du mode disque, 131, effacement
de fichier, 140, statut de la disquette, 133, entrée et sortie du mode
disque, 131, référence des fonctions, 131, formatage de disquettes,
141, chargement a partir de disquettes, 136, déplacement en mode
disque, 131, description des modes de fonctionnement, 21, ré-
assignation de nom a un fichier, 139, sauvegarde sur disquettes,
134, sélection des fichiers, 132.

MODE SONG JOB voir mode d’opérations de morceaux
MODE SONG voir mode de morceaux

MODE UTILITAIRE, controleurs, 147, entrée et sortie du mode utilitaire,
142, référence des fonctions, 142, message de bienvenue, 149, ré-
initialisation de la banque de sonorités internes, 144, configurations
MIDI, 148, déplacement en mode utilitaire, 142, description des
modes de fonctinnnement, 21, autres configurations, 149, mémoire
de sonorités de morceaux, 143, configuration du synthétiseur, 145

MODES, voir mode de changement de données, mode de graphique de
données, mode d'insertion de données, mode disque, mode
d'édition de sonorités rythmiques, mode d’édition de sonorités
normales, mode d’enregistrement en temps réel, mode solo, mode de
morceaux, mode de jeu de multis de morceaux, mode de jeu de
morceaux, mode d’enregistrement de morceaux, mode d’enregistre-
ment pas a pas, mode de sauvegarde, mode utilitaire, mode d'édition
des sonorités, mode de sonorités, mode de jeu des sonorités.

MODIFICATION DE LA VELOCITE, opération de morceau Song Job 3,
102

MODIFICATION DU TEMPS DE PORTE, opération de morceau Song
Job 3,101

MODULATION, LFO, 121
MODULATION LFO, 121

MODULE DE CHORUS, description et diagramme des effets du systeme,
79

MODULE DE RETARD/DE REVERBERATION, description et diagramme
des effets du systeme, 79

MODULE DE REVERBERATION, diagramme et description des effets du
systeme, 79

MODULES D’EFFETS DU SYSTEME 1, diagramme et description, 79

MOLETTE DE HAUTEUR, description de la commande de la molette de
hauteur de son, 50, description et diagramme du panneau avant, 12

MOLETTE DE MODULATION, contréleur, 123, description de la
commande de la molette de modulation, 50, description et
diagramme du panneau avant, 12

MOLETTE JOG/SHUTTLE, description et diagramme du panneau avant,
14, fonctions, 42

MORCEAU, s¢lection d’'un morceau au sein du répertoire de morceaux,
81, sélection de morceau, 80, création de morceaux, 82

MORCEAU SUIVANT “NEXT SONG?”, autres configurations, 84

MORCEAUX DE DEMONSTRATION, chargement et jeu des morceaux
de démonstration, 52

MULTI, diagramme des canaux du mélangeur, 24, multis de morceaux,
23, étapes de procédure dans la définition d'un multi, 56, 74,
sauvegarde de multi, 39, 129

MULTI DE MORCEAU, accés aux multis de morceaux, 75, référence des
fonctions, 74, affichage des parametres d'instruments, 75, sélection
des parametres d'instruments, 75, sélection des pistes d'instruments,
75, diagramme des canaux du mélangeur, 24, déplacement en
multis de morceaux, 76, apercu général, 23, écran de multis de
morceaux, 76, étapes dans la définition d'un multi, 56, étapes dans
la définition d'un multi de morceaux, 74

MUTE, voir assourdissement

N

NETTOYAGE, nettoyage de la téte de lecture/d’écriture du lecteur de
disquettes, 6, nettoyage de I'instrument, 5

NIVEAU D’AMPLITUDE, édition de I'amplitude des éléments, 113

NIVEAU D’ENVOI DES EFFETS DU SYSTEME, mode d’édition des
sonorités rythmiques, 127, paramétre de touche des sonorités
rythmiques, 126, mode d'édition des sonorités normales, 119,

NIVEAU D’ENVOI DES SONORITES, comment y accéder, 80
NIVEAU DE RENVOI GLOBAL, comment y accéder, 77

NIVEAU DE VOLUME, parametre touche pour les sonorités rythmiques,
126

NOM, nom de sonorité rythmique, 125, assignation de nom a un fichier,
132, nommer un morceau, 81, nom de sonorité normale, 110

NOM DE MORCEAU, comment assigner un nom a un morceau, 81

NOM DE SONORITES, parametre commun des sonorités rythmiques,
125, parametre commun des sonorités normales, 110

NOMBRE D’ELEMENTS, parametre d’élément des sonorités normales,
112

NORMAL, mode de clavier normal, 83, mode d’édition de sonorités
normales, 109, enregistrement pas & pas, 89

NOTE, changement de hauteur de note d'un élément, 118, insertion de
données de notes, 94, limite de note d’élément pour les sonorités
normales, 113, capacité de notes/polyphonie, 25, capacité de notes
simultanées, 74

o

OCTAVE, mode de clavier en 4 zones, 83

OPERATION DE MORCEAU 1, annexe de morceau, 96, effacement de
morceau, 96, effacement de piste, 97, copie de morceau, 96, copie
de piste, 97, référence des fonctions, 96, mélange de pistes, 97

OPERATION DE MORCEAU 2, tri des accords, 100, copie de mesures,
98, création de mesures, 98, effacement de mesures, 99, suppression
de mesures, 98, extraction, 99, référence des fonctions, 98, insertion
de mesures, 99, élagage, 99

OPERATION DE MORCEAU 3, crescendo, 103, référence des fonctions,
100, modification du temps de porte, 101, modification de la
vélocité, 102, déplacement d'horloge, 101, quantification, 100,
changement ou décalage de note, 103, transposition, 102

OSCILLATEUR BASSES FREQUENCES, voir LFO
OUTPUT (sortie), parametre de touche des sonorités rythmiques, 126
OVERDUB (DOUBLAGE), enregistrement en temps réel, 88

P

PANNEAU, diagramme du panneau avant, 10, diagramme du panneau
arriere, 15

PANORAMIQUE, positionnement panoramique de l'élément de touche
dans les sonorités rythmiques, 126, panoramique des éléments dans
les sonorités normales, 112, sélection et réglage du panoramique des
sonorités, 54, écran de multis de morceaux, 36, panoramique des
sonorités, 77

PANORAMIQUE DE SONORITES, écran de multis de morceaux, 36

PANORAMIQUE DES ELEMENTS, parametre d'élément des sonorités
normales, 112

PARAMETRE, commande d'effet d'insertion pour les sonorités rythmi-
ques, 127, parametre d'effet d'insertion pour les sonorités rythmi-
ques, 127, LFO, 121, commande d'effet d'insertion pour les
sonorités normales, 120, parametre d'effet d’insertion pour les
sonorités normales, 120

—
[@)]
(VS

%
5
Z
=
O
(i



Unknown
 


%
ae)
wy)
Z
=164
e

PARAMETRE COMMUN, mode d'édition des sonorités rythmiques, 125,
mode d’édition des sonorités normales, 110

PARAMETRE COMMUN DE SONORITE NORMALE, 110

PARAMETRE COMMUN DES SONORITES RYTHMIQUES, mode
d'édition des sonorités rythmiques, 125

PARAMETRE D’EFFET D'INSERTION, mode d'édition des sonorités
rythmiques, 127, mode d'édition des sonorités normales, 120

PARAMETRE DE TOUCHE DES SONORITES RYTHMIQUES, mode
dédition des sonorités rythmiques, 125

PARAMETRE LFO, 121

PARAMETRE TOUCHE, acces aux parametres de touche des sonorités
rythmiques, 125, mode d’édition des sonorités rythmiques, 125

PARAMETRES DES EFFETS DU SYSTEME, description et comment y
accéder, 79, comment accéder, 78

PARTAGE, mode de partage du clavier, 83, point de partage du clavier,
83, assignation supérieure/inférieure au partage du clavier, 83

PAVE NUMERIQUE, entrée de données, 42, entrée de données dans
I'enregistrement pas a pas, 90

PAVE NUMERIQUE D’ENTREE DE DONNEES, description et dia-
gramme du panneau avant, 14, comment l'utiliser, 42

PEDALE DE VOLUME, description de la commande de la pédale de
volume, 50

PEG, voir générateur d'enveloppe de hauteur
PIANO, valeur de vélocité dans 'enregistrement pas a pas, 90

PISTE, entrée de données par les touches de pistes, 41, sélection des
pistes pour la restitution, 74, sélection des pistes, 54, touches de
pistes, 13, touche de sélection de piste, 13

PITCH BEND, controleur d'élément, 122, insertion de données de pitch
bend, 94, écran de multis de morceaux, 37

PLAGE DE PITCH BEND, comment y accéder, 78, controleur de pitch
bend, 122,

écran de multis de morceaux, 37

PLAGE DU GENERATEUR D’ENVELOPPE, sensibilité¢ de hauteur de son
de I'élément, 118

PMD, voir profondeur de la modulation de hauteur

POLYPHONIE, sonorités d'instruments et polyphonie, 25, capacité de
notes simultanées, 74

POSITIONNEMENT PANORAMIQUE, paramétre de touche des
sonorités rythmiques, 126

PRECAUTIONS, précautions a prendre et autres instructions importan-
tes, 5

PRISE DE PEDALE DE VOLUME, description et diagramme du panneau
arriere, 16

PRISE PHONES, description et diagramme du panneau arri¢re, 16

PROCEDURE DE MISE SOUS TENSION, comment démarrer, 45

PROFONDEUR DE LA MODULATION DE HAUTEUR, 121, controleur
d'apres-toucher, 122, commande au pied, 123, controleur de la
molette de modulation, 123

PROFONDEUR DE MODULATION D’AMPLITUDE, 121

PROFONDEUR DE MODULATION D’AMPLITUDE, contrdleur d’apres-
toucher, 122, commande au pied, 123, controleur de la molette de
modulation, 123

PROFONDEUR DE MODULATION DU FILTRE, controleur d'apres-
toucher, 122, commande au pied, 123, contréleur de la molette de
modulation, 123

PROGRAMMATION, comment démarrer, 56

Q

Quantification, opération de morceau Song Job 3, 100, mode d'enregis-
trement de morceaux, 86

QUATRE ZONES, mode de partage de clavier en 4 zonss, 83

R

RE-INITIALISATION, controleur de configuration du synthétiseur, 145

RE-INITIALISATION DE LA BANQUE DE SONORITES INTERNE,
mode utilitaire, 144

RE-INITIALISER, parametre commun des sonorités rythmiques, 125,
parametre commun des sonorités normales, 110, mode utilitaire,
144

RECUL, parametre de touche des sonorités rythmiques, 126
REFAIRE, opération de morceau Song Job défaire/refaire, 95
REMPLACEMENT, enregistrement en temps réel, 88

RENOMMER UN FICHIER, mode disque, 137

RENVOIS, niveau de renvoi principal du mélangeur, 77
REPERTOIRE, répertoire de fichiers, 132, répertoire de morceaux, 81
REPERTOIRE DE FICHIERS, mode disque, 132

REPERTOIRE DE MORCEAUX, comment y accéder, 81, sélection d’'un
morceau au sein de, 81

REPERTOIRE DES SONORITES, comment y accéder, 78, écran de
multis de morceaux, 37

RESONNANCE/BANDE, filtre, 116
RESTITUTION, sélection des pistes pour la restitution, 74

RESTITUTION DE MORCEAUX, exploration des options de restitution
de morceaux, 54

RETARD, LFOQ, 121
RETARD LFO, 121
RYTHME, mode d'¢dition des sonorités rythmiques, 124

S

SAUVEGARDE, mode de sauvegarde, 129, sauvegarde de multi, 39, 129,
sauvegarde de sonorité, 39, 130, sauvegarde d’une sonorité, 108

SAUVEGARDE D'UNE SONORITE, 108

SAUVEGARDE DE MULTI, acces 2 la fonction de sauvegarde de mult,
129, avant de sauvegarder un multi, 129, description, type de
données qui peuvent étre sauvegardées et comment les utiliser, 39,
sélection d'un emplacement de morceau, 129, mode de sauvegarde,
129

SAUVEGARDE DE SONORITES, acces 2 la fonction de sauvegarde de
sonorités, 130, avant de sauvegarder une sonorité, 130, description
et types de sonorités pouvant étre sauvegardées, 39, sélection d'un
emplacement de sonorité, 130

SAUVEGARDE ET CHARGEMENT, comment sauvegarder et charger des
données, 64

SAUVEGARDE SUR DISQUETTE, acceés 2 la fonction de sauvegarde sur
disquette, 134, mode disque, 134, sauvegarde de toutes les données,
134, sauvegarde d’'un morceau, 134, sauvegarde d'un morceau +
sonorité, 135, sauvegarde en format SMF, 135, sauvegarde de
sonorités, 135

SECTION DE MODES, description et diagramme du panneau avant, 12

SECTION DES CONTROLEURS, description de l'architecture du
systeme, 22

SECTION DU SEQUENCEUR, description et diagramme du panneau
avant, 12, description de l'architecture du systeme, 22


Unknown
 


SECURITE, mesures de sécurité et autres instructions importantes, 5
SELECTION D’ELEMENTS, 109
SELECTION D'UN MORCEAU, # partir du répertoire de morceaux, 81

SELECTION DE BANQUE D'ELEMENT, parametre de touche pour les
sonorités rythmiques, 125

SELECTION DE BANQUE DE SONORITES, écran de multi de
morceaux, 37

SELECTION DE PISTE, sélection de piste instrumentale, 63,
SELECTION DE PISTES, sélection des pistes pour la restitution, 74
SELECTION DE SONORITES, écran de multis de morceaux, 36

SELECTION DE TOUCHE, paramétre de touche des sonorités rythmi-
ques, 125

SELECTION DES PISTES ET REGLAGE DES PARAMETRES, comment
démarrer, 534

SELECTION DU NUMERO D’ELEMENT, parametre de touche des
sonorités rythmiques, 126

SENSIBILITE, description de la commande de sensibilité 2 la vélocité du
clavier, 51, sensibilité a la hauteur de son des éléments, 118,
sensibilité a la vélocité du filtre, 116, hauteur de son, 118

SENSIBILITE A LA BANDE DE VELOCITE, filtre, 116

SENSIBILITE A LA VELOCITE, parametre de niveau d’amplitude, 113,
description de la commande de sensibilité a la vélocité du clavier,
51, sensibilité a la hauteur de I'élément, 118, filire, 116, enregistre-
ment pas a pas, 90

SENSIBILITE DU CLAVIER A LA VELOCITE, description de la
commande de sensibilité du clavier a la vélocité, 51

SEQUENCE, jeu d'une séquence de morceau, 73, graphique des
séquences de pistes, 91, jeu de séquences de morceaux, 80

SEQUENCE DE MORCEAU, jeu d'une séquence de morceau, 73, jeu de
séquences de morceau, 80

SEQUENCEUR, acces 4 une fonction ou a un parametre d’enregistrement
de morceaux, 86, jeu d'une séquence de morceaux, 73, commandes
du séquenceur, 61, section du séquenceur, 22, jeu de séquences de
morceaux, 80, utilisation des commandes du séquenceur, 86

SLUR voir liaison

SMF, chargement a partir d'une disquette, 137, sauvegarde sur disquette,
135, sauvegarde et chargement, 131

SOLO, mise en solo et assourdissement des instruments, 55, mise en solo
et assourdissement de pistes, 74

SONG JOB voir opération de morceau
SONG RECORD voir enregistrement de morceaux
SONG voir morceau

SONORITE, différence entre une sonorité normale et une sonorité
rythmique, 58, paramétre commun des catégories de sonorités
rythmiques, 125, diagramme des éléments, 30, exploration des
sonorités pré-programmeées, 45, comment sélectionner une sonorité,
46, chargement a partir d'une disquette, 138, diagramme des canaux
du mélangeur pour les sonorités normales et rythmiques, 24,
parametre commun des catégories de sonorités normales, 110,
sonorités rythmiques et normales, 106, rappel des sonorités internes
pré-programmées a l'usine, 144, rechargement des données de
sonorités programmeées a l'usine, 66, description de la mémoire de
sonorités de morceaux, 38, sauvegarde de sonorités, 39, 130,
sauvegarde d'une sonorité¢, 108, réglage de niveau d’envoi des effets
du systeme pour les sonorités, 77, niveau d'envoi des effets du
systeme pour les sonorités, 80, description des banques de sonorités
et liste des différents types, 25, transfert de blocs de sonorités, 144,
catégories de sonorités, 27, commande des sonorités, 105, mode
dédition des sonorités, 108, mode des sonorités, 106, réglage de la
plage de pitch bend pour les sonorités, 78, mode de jeu des
sonorités, 107, sélection de sonorités, 36, sélection de sonorité, 77,
volume de sonorité, 36, volume, 77

SONORITE DE MORCEAU, description et comment la gérer, 38,
mémoire de sonorités de morceaux, 143, sauvegarde de sonorités de
morceaux, 130

SONORITE NORMALE, description et diagramme, 106, parametres
deeffets, 119, diagramme des canaux du mélangeur, 24, codes
d'abréviations des banques de sonorités et leurs descriptions, 25

SONORITE RYTHMIQUE, codes d’abréviation des banques de sonorités
et descriptions, 26

SONORITE RYTHMIQUE, description et diagramme, 106, parametres
deeffets, 127, diagramme des canaux du mélangeur, 24

SONORITE SEULE, chargement d’une seule sonorité, 138
SONORITES, COMPARAISON/EDITION, 108
SONORITES INSTRUMENTALES, définition, 25

SONORITES INTERNES, sauvegarde de sonorités internes, 130, rappel
des sonorités internes pré-programmeées d'usine, 144

SONORITES PRE-SELECTIONNEES, exploration, 45
SOURCE D'ALIMENTATION, précautions & prendre, 5

SOUTIEN AU PIED, description de la commande de la pédale de sustain,
50

SPECIFICATIONS TECHNIQUES, appendice, 156
STACCATO, enregistrement pas a pas, 89

STATUT DU DISQUE, acces a la fonction de statut du disque, 133, mode
disque, 133

STORE voir sauvegarde

SUPERPOSE, mode de clavier superposé, 83, assignation inférieure,
supérieure du clavier superpos¢, 83

SUSTAIN, controleur de I'élément de, 122, pédale de, 50
SYNCHRONISATION, autres configurations de morceaux, 84

SYSTEME, architecture du systeme, 22, logique du systeme, 17,
diagramme général du systeme, 18

SYSTEME EXCLUSIVE, insertion de données exclusives du systeme, 94

T

TEMPLATE, type template de I'élément d'amplitude, 113, type template
du filtre, 116, type template du LFO, 121, type template de hauteur
de son, 117

TEMPO, changement de tempo, 55, données de changement de tempo
pour les pistes, 93, insertion de données de tempo dans une piste,
94, changement de tempo, 94, sélection du tempo, 80, sélection du
tempo, 86

TEMPS DE PORTE, parametre de touche des sonorités rythmiques, 126
THIN OUT, voir ¢lagage

THRU (THROUGH), filtre, 115

TON, filtre, 116

TOUCHE, assignation d’éléments aux touches pour les sonorités
rythmiques, 125, parametre “touche” des sonorités rythmiques, 125,
sélection de touche pour les sonorités rythmiques, 125, description
de la vélocité des touches, 31

TOUCHE “CANCEL", touche d'annulation “cancel”, 42, description et
diagramme du panneau avant, 14, quand l'utiliser, 42

TOUCHE D'EDITION DE SONORITES (VOICE EDIT), description et
diagramme du panneau avant, 13

TOUCHE DE DONNEES/DE CURSEUR, description et diagramme du
panneau avant, 14, statut d’activation et de désactivation, 42

TOUCHE DE MISE DE PISTE EN SOLO, description et diagramme du
panneau avant, 13
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TOUCHE DE SAUVEGARDE, description et diagramme du panneau
avant, 12

TOUCHE DE SELECTION DE PISTE, description et diagramme du
panneau avant, 13

TOUCHE EXIT, description et diagramme du panneau avant, 13
TOUCHE SHIFT, description et diagramme du panneau avant, 13

TOUCHES DE FONCTIONS, description et diagramme du panneau
avant, 13

TOUCHES DE PISTES, entrée de données par, 41, description et
diagramme du panneau avant, 13, sélection des éléments et leur
activation ou désactivation, 109

TOUCHES INC/DEC, description et diagramme du panneau avant, 14,
comment les utiliser, 42

TOUTES LES PISTES, description, 87, enregistrement en temps réel, 88
TRACK voir piste

TRANSFERT DE BLOCS DE DONNEES, mode utilitaire, 144
TRANSFERT DE BLOCS DE SONORITES, mode utilitaire, 144

TRANSPOSITION, opération de morceaux Song Job 3, 102, autres
configurations de morceaux, 84

TRI DES ACCORDS, opération de morceau “Song Job™ 2, 100

TYPE, type d'effet d'insertion pour les sonorités rythmiques, 127, type
template pour I'amplitude des éléments, 113, types de fichiers, 132,
type template pour le filtre, 116, type template pour Loscillateur
basses fréquences, 121, type d'effet d’insertion pour les sonorités
normales, 119, type template pour la hauteur de son, 117, sélection
d’un type de fichier, 132

TYPE D’EFFET D'INSERTION, mode d'édition des sonorités rythmiques,
127, mode d’édition des sonorités normales, 119

TYPE D’EFFET DU SYSTEME, descriplion et comment accéder, 79,
comment accéder, 77

TYPE DE FICHIER, sélection d'un type de fichier, 132, codes 2 trois
caracteres, 132

TYPE DE FILTRE “TEMPLATE”, 116

TYPE TEMPLATE, édition de l'amplitude des ¢léments, 113, filtre, 116,
LFO, 121, hauteur de son, 117

TYPE TEMPLATE DE HAUTEUR DE SON, 117

v

VALEUR DE RE-INITIALISATION DE LA COMMANDE AU PIED,
controleurs du mode utilitaire, 147

REFERENCE DES FONCTIONS, 71
VALEUR INITIALE, commande au pied, 147

VALEURS DE RE-INITIALISATION, valeurs de ré-initialisation
communes des sonorités normales, 110, valeurs de ré-initialisations
des éléments de sonorités normales, 111

VALEURS DE RE-INITIALISATION COMMUNES, sonorités normales,
110

VALEURS DE RE-INITIALISATION DES ELEMENTS, sonorités
normales, 111

VELOCITE, description de la commande de sensibilité 2 la vélocité du
clavier, 51, sensibilité de hauteur de I'élément, 118, sensibilité a la
vélocité de bande du filtre, 116, sensibilité a la vélocité de filtre, 116,
description de la vélocité de touche, 31, limite de vélocité des
élements pour les sonorités normales, 112, enregistrement pas a pas,
90, configuration du synthétiseur, 145

VELOCITE DE TOUCHE, description, 31
VITESSE, LFO, 121
VITESSE LFO, 121

VOLUME, parametre commun des sonorités rythmiques, 125, niveau de
volume de touche des sonorités rythmiques, 126, commande de la
pédale de volume, 50, volume global, 77, parametre commun des
sonorités normales, 110, sélection et réglage du volume des
sonorités, 54, volume de sonorité, 77

VOLUME DES SONORITES, écran de multis de morceaux, 36

VOLUME GENERAL, écran de multis de morceaux “Song Multi", 36,
sélection du volume de la sonorité, 77

VOLUME PRINCIPAL, assignation de pédale de volume, 147

VUE DU CLAVIER, graphique des pistes de séquences, 91, enregistre-
ment pas a pas, 90
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CANADA

THIS DIGITAL APPARATUS DOES NOT EXCEED THE "CLASS B" LIMITS
FOR RADIO NOISE EMISSIONS FROM DIGITAL APPARATUS SET OUT IN
THE RADIO INTERFERENCE REGULATION OF THE CANADIAN DEPART-
MENT OF COMMUNICATIONS.

 This applies only to products distributed by Yamaha Canada Music .TD.

LE PRESENT APPAREIL NUMERIQUE N'EMET PAS DE BRUITS
RADIOELECTRIQUES DEPASSANT LES LIMITES APPLICABLES AUX
APPAREILS NUMERIQUES DE LA "CLASSE B" PRESCRITES DANS LE
REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE EDICTE PAR LE
MINISTERE DES COMMUNICATIONS DU CANADA.

e Ceci ne s'applique qu'aux produits distribués par Yamaha Canada Music LTD.
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FCC INFORMATION (U.S.A)

1. IMPORTANT NOTICE: DO NOT MODIFY THIS UNIT!

This product, when installed as indicated in the instructions contained in this manual, meets FCC requirements. Modifications not expressly approved
by Yamaha may void your authority, granted by the FCC, to use the product.

2. IMPORTANT: When connecting this product to accessories and/or another product use only high quality shielded cables.

Cable/s supplied with this product MUST be used. Follow all installation instructions. Failure to follow instructions could void your FCC authorization to
use this product in the USA.

3. NOTE: This product has been tested and found to comply with the requirements listed in FCC Regulations, Part 15 for Class ‘B digital devices.
Compliance with these requirements provides a reasonable level of assurance that your use of this product in a residentia! environment will not resuit
in harmful interference with other electronic devices. This equipment generates/uses radio frequencies and, if not installed and used according to the
instructions found in the user's manual, may cause interference harmful to the operation of other electronic devices. Compliance with FCC regutations
does not guarantee that interference will not occur in all installations. If this product is found to be the source of interference, which can be determined

Buena Park, CA 90620

by turning the unit "OFF" and *ON", please try to eliminate the problem by using one of the following measures :
Relocate either this product or the device that is being affected by the interference.
Utilize power outlets that are on different branch (circuit breaker or fuse) circuits or install AC line filter/s.

In the case of radio or TV interference, relocatefreorient the antenna.
If the antenna lead-in is 300 ohm ribbon lead, change the lead-in to co-axial type cable.

If these corrective measures do not produce satisfactory results, please contact the your local retailer authorized to distribute this type of product.
If you can not locate the appropriate retailer, please contact Yamaha Corporation of America, Electronic Service Division, 6600 Orangethorpe Ave,

The above statements apply ONLY to those products distributed by Yamaha Corporation of America or its subsidiaries.

Litiumbatteri!
Bér endast bytas av servicepersonal.
Explosionstara vid felaktig hantering.

VAROITUS!
Lithiumparisto, Rajahdysvaara.
Pariston saa vaihtaa ainoastaan alan ammattimies.

ADVARSEL!

Lithiurnbatter!

Eksplosionstare. Udskiftning ma kun foretages af en sagkyndig, - og som
beskrevet i servicemanualen.

Wichtiger Hinweis tir die Benutzung in der Bundesrepublik Deutschiand.

Bescheinigung des Importeurs
Hiermit wird bescheinigt,daB der/die/das
Gerdt: Synthesizer Typ: W5
{Gerat, typ, Bezeichnung)
in Ubereinstimmung mit den Bestimmungen der

VERFUGUNG 1046/84
(Amtsblattverfagung)

funkentstért ist.

Der Deutschen Bundespost wurde das Inverkehrbringen dieses Gerétes
angezeigt und die Berechtigung zur Uberprufung der Serie auf
Einhaltung der Bestimmungen eingerdumt.

Y ha Eur mbH

(Name des Importeurs)

Dit produkt is gefabriceerd in overeenstemming met de
radiostoringsvoorschriften van de Richtlijn van de Raad(82/499/EEG).

AYTH H LYZKEYH ANTAIIOKPINETAI ZTIZ ATTAITHZEIZ TQN
OAHTIQN THZ EYPQITAIKHEZ OIKONOMIKHE KOINOTHTAE 82/499/
E.OK..

Este produto estd de acordo com o radio de interferencia frequente requiridos do
Conselho Diretivo 82/499/EEC.

Dette apparat overholder det gacldende EF-direktiv vedrarende radiostg;.

Cel appareil est conforme aux prescriptions de la directive communautaire 87/
308/CEE.

Diese Gerite entsprechen der EG-Richtlinie 82/499/EWG und/oder 87/308/
EWG.

This product complies with the radio frequency interference requirements of the
Council Directive 82/499/EEC and/or 87/308/EEC.

Questo apparecchio é conforme al D.M.13 aprile 1989 (Direttiva CEE/87/308)
sulla soppressione dei radiodisturbi.

Este producto estd de acuerdo con los requisitos sobre interferencias de radio
frequencia fijados por el Consejo Directivo 87/308/CEE. ﬂ

YAMAHA CORPORATION -[

sDies bezieht sich nur auf die von der Yamaha Europa GmbH Vertriebenen Produkte

Wichtiger Hinweis fiir die Benutzung in der Bundesrepublik Deutschland.

Bescheinigung des Importeurs
Hiermit wird bescheinigt.daB der/die/das
Gerdt: Synthesizer Typ: W7
(Gerat, typ, Bezeichnung)
in Ubereinstimmung mit den Bestimmungen der

VERFUGUNG 1046/84
(Amtsblattverfigung)

funkentstort ist.

Der Deutschen Bundespost wurde das Inverkehrbringen dieses Gerétes
angezeigt und die Berechtigung zur Uberprifung der Serie auf
Einhaltung der Bestimmungen eingerdumt.

Yamah. r mbH

(Name des Importeurs)

IMPORTANT NOTICE FOR THE UNITED KINGDOM

Connecting the plug and Cord

WARNING: THIS APPARATUS MUST BE EARTHED
IMPORTANT: THE WIRES IN THIS MAINS LEAD ARE COLOURED IN
ACCORDANCE WITH THE FOLLOWING CODE:

GREEN-AND-YELLOW : EARTH
BLUE : NEUTRAL
BROWN : LIVE

As the colours of the wires in the mains lead of this apparatus may not
correspond with the coloured markings identifying the terminals in your
plug proceed as follows:

The wire which is coloured GREEN-and-YELLOW must be connected to
the terminal in the plug which is marked by the letter E or by the safety
earth symbol or colored GREEN or GREEN-and-YELLOW.

The wire which is coloured BLUE must be connected to the terminai
which is marked with the letter N or coloured BLACK.

The wire which is coloured BROWN must be connected to the terminal
which is marked with the letter L or coloured RED.

*Dies bezieht sich nur auf die von der Yamaha Europa GmbH Vertriebenen Produkie

168




For.details of products, please contact your nearest Yamaha or the Die Einzelheiten zu Produkten sind bei Ihrer unten aufgefiihrten

authorized distributor listed below.

Niederlassung und bei Yamaha Vertragshindlern in den jeweiligen
Bestimmungslidndern erhéltlich.

Pour plus de détails sur les produits, veuillez-vous adresser 3 Yamaha Para detalles sobre productos, contacte su tienda Yamaha mds cercana
ou au distributeur le plus proche de vous figurant dans la liste suivante. o el distribuidor autorizado que se lista debajo.
I NORTH AMERICA | FRANCE | ASIA
Yamaha Musique France,
CANADA Division Instr ts Electroniques et de Scéne HONG KONG
Yamaha Canada Music Ltd. BP 70-77312 Marne-ta- Valée Cedex 2, France Tom Lee Music Co., Ltd.
135 Milner Avenue, Scarborough, Ontario, Tel: 01-64-61-4000 11/F., Silvercord Tower 1, 30 Canton Road,
M1S 3RI, Canada Tsimshatsui, Kowloon, Hong Kong
Tel: 416-298-1311 ITALY Tel: 730-1098
Yamaha Musica Italia S.P.A.,
US.A. Combo Division INDONESIA
Yamaha Corporation of America Viale Italia 88, 20020 Lainate (Milano), ltaly PT. Yamaha Music Indonesia(Distributor)
6600 Orangethorpe Ave., Buena Park, Calif. 90620, Tel: 02-935-771 PT. Nusantik
US.A. Gedung Yamaha Music Center, Jalan Jend. Gatot
Tel: 714-522-9011 SPAIN Subroto Kav. 4, Jakarta 12930, Indonesia
Y ha-Hazen Electronica Musical, S.A. Tel: 21-520-2577
[ MIDDLE & SOUTH AMERICA | Jorge Juan 30, 28001, Madrid, Spain
Tel: 91-577-7270 KOREA
MEXICO Cosmos Corporation
Yamaha De Mexico S.A. De C.V., PORTUGAL #131-31, Neung-Dong, Sungdong-Ku, Seoul
Departamento de ventas Valentim de Carvalho CI SA Korea
Javier Rojo Gomez No.1149, Col. Gpe Del Estrada de Porto Salvo, Pago de Arcos 2780 Oeiras, Tel: 02-466-0021~5
Moral, Deleg. 1ztapalapa, 09300 Mexico, D.F. Portugal
Tel: 686-00-33 Tel: 01-443-3398/4030/1823 MALAYSIA
Yamaha Music Malaysia, Sdn., Bhd.
BRASIL GREECE 16-28, Jalan SS 2/72, Petaling Jaya, Selangor,
Yamaha Musical Do Brasil LTDA. Philippe Nakas S.A, Malaysia
Ave. Reboucas 2636, Sao Paulo, Brasil Navarinou Street 13, P.Code 10680, Athens, Greece Tel: 3-717-8977
- §5- . Tel: 01-364-7111
Tel: 55-11 853-1377 PHILIPPINES
PANAMA SWEDEN Yupangco Music Corporation
Yamaha De Panama S.A. Yamaha Scandinavia AB 339 Gil J. Puyat Avenue, P.O. BOX 885 MCPO,
Edificio Interseco, Calle Elvira Mendez no.10, J.A. Wettergrens gata 1, Box 30053, 400 43 Makati, Metro Manila, Philippines
Piso 3, Oficina #1053, Ciudad de Panama, Panama Goteborg, Sweden Tel: 819-7551
. 507-69- Tel: 031-496090
Tel: 507-69-5311 € SINGAPORE
OTHER LATIN AMERICAN COUNTRIES DENMARK Yamaha Music Asia Pte., Ltd. )
AND CARIBBEAN COUNTRIES Yamaha Scandinavia Filial Denmark Blk 17A Toa Payoh #01-190 Lorong 7
Yamaha Mausic Latin America Corp. Generatorvej 8B, 2730 Herlev, Denmark Singapore 1231
6101 Blue Lagoon Drive, Miami, Florida 33126, Tel: 44 92 49 00 Tel: 354-0133
Tot 3052614111 FINLAND TAIWAN
el 209-201- Fazer Music Inc. Kung Hsue She Trading Co., Ltd.
Aleksanterinkatu 11, SF (0100 Helsinki, Finland No. 322, Section 1, FuHsing S. Road,
EUROPE Tel: 0435 011 Taipei 106, Taiwan. R.O.C.
THE UNITED KINGDOM NORWAY Tel: 02-709-1266
Yamaha-Kemble Music (U.K.) Ltd. Narud Yamaha AS THAILAND
Sherbourne Drive, Tilbrook, Milton Keynes, Dsterndalen 29, 1345 Osterds Siam Music Yamaha Co., Ltd.
MK?7 8BL, England Tel: 02-24 47 90 865 Phornprapha Building, Rama I Road,
Tel: 0908-366700 i
e ICELAND ?:;:?r;j;?g:f&r;gkok 10330, Thailand
IRELAND Pill H. Palsson
Danfay Limited P.O. Box 85, 121 Reykjavik, Iceland THE PEOPLE’S REPUBLIC OF CHINA
61D, Sallynoggin Road, Dun Laoghaire, Co. Dublin Tel: 01-19440 AND OTHER ASIAN COUNTRIES
Tel: 01-2859177 A
EAST EUROPEAN COUNTRIES Yamaha Corporation,

GERMANY/SWITZERLAND
Yamaha Europa Gmi:H.
SiemensstraBe 22-34, D-2084 Rellingen, F.R. of
Germany
Tel: 04101-3030

AUSTRIA/JHUNGARY/SLOVENIA/
ROMANIA/BULGARIA
Yamaha Music Austria GesmbH.
Schleiergasse 20, A-1100 Wien Austria
Tel: 0222-60203900

THE NETHERLANDS
Yamaha Music Benelux B.V.,
Verkoop Administratie
Kanaalweg 18G, 3526KL, Utrecht, The Netherlands
Tel: 030-828411

BELGIUM/LUXEMBOURG
Yamaha Music Benelux B.V.,
Brussels-office
Keiberg Imperiastraat 8, 1930 Zaventem, Belgium
Tel: 02-7258220

International Marketing Division

(Except HUNGARY) Nakazawa-cho 10-1, Hamamatsu, Japan 430
Yamaha Europa GmbH. Tel: 053-460-2311
Siemensstrafie 22-34, D-2084 Rellingen, F.R. of
Germany
Tel: 04101-3030 [ OCEANIA |
AFRICA | AUSTRALIA
. Yamaha Music Australia Pty. Ltd.
Yamaha Corporation, 17-33 Market Street, South Melbourne, Vic. 3205,
International Marketing Division Australia
Nakazawa-cho 10-1, Hamamatsu, Japan 430 Tel: 3-699-2388
Tel: 053-460-2311
NEW ZEALAND
MIDDLE EAST ] Music Houses of N.Z. Ltd.
TURKEY/CYPRUS 146/148 Captain Springs Road, Te Papapa, Auckland,
Yamaha Musique France, Division Export _I;_le:v 9Z;§I‘;ar;)dmg
BP 70-77312 Marne-la-Valée Cedex 2, France el 5-654-
Tel: 01-64-61-4000 COUNTRIES AND TRUST
OTHER COUNTRIES TERRITORIES IN PACIFIC OCEAN

Yamaha Corporation,
International Marketing Division International Marketing Division

Nakazawa-cho 10-1, Hamamatsu, Japan 430 Nakazawa-cho 10-1, Hamamatsu, Japan 430
Tel: 053-460-2311 Tel: 053-460-2311

Yamaha Corporation,

SY05

HEAD OFFICE Yamaha Corporation, Electronic Musical Instrument Division
Nakazawa-cho 10-1, Hamamatsu, Japan 430
Tel: 053-460-2445
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